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SECTION 1: INSTALLATION 

1.1 Windows 
This User's Manual was written to the 
Windows version of Wings3D, however the 
concepts and commands discussed herein 
should be generally applicable to all platforms 
to the best of my knowledge. An effort will be 
made to explain where operations differ via 
platform. If you find differences that are not 
addressed please forward that information to 
the author so that the manual can be 
updated appropriately. Send changes, 
additions and corrections to jstro@swbell.net 
. 
Wings3D is written in the Erlang 
programming language, however there is no 
need for you to download the Erlang binaries 
since the ones needed for Wings are 
compiled right into the Wings distribution. If 
you want to become a Wings developer you 
will need to download the full Erlang 
distribution. You can download both the 
Erlang source and runtime libraries and 
Wings3D binaries for Windows from the 
Wings home page: 
 
http://www.wings3d.com/ 
 

These binaries will work for all versions of 
Windows. The Wings binaries are small, 
approximately 1.6 MB. The Wings download 
is a self extracting installer, simply double 
click on it to install Wings. When a new 
version of Wings becomes available, simply 
download the new binaries for Wings and 
reinstall it right over the old installation. 
You may also want to download the sample 
plug-ins located at the same site. These 
should be installed in your Wings plug-ins 
directory, which was created when you 
installed Wings. They are useful for 
developers to examine who are considering 
writing their own plug-ins. A list of plugins 
available can be found in section 6: Plugins 

Quick Tip: Plugins don’t work with 
all versions of Wings3D. 
Plugins have to be programmed to work with 
each version of wings. Because of the speed 
in which Wings3D is updated you may find 
that a plugin only works with a particuler 
update. Because of this check the wings 
version you downloaded against the versions 
the plugin will work with.  
Tip by Jason McAlpin

 

1.3 Solaris® 
The Solaris® installation instructions are the same as for Linux®. 
 

1.4 Mac 
The Mac installation requires OS X 10.2 or 
higher. There is no need to install Erlang 
since everything is already compiled into the 
application. Download and Open the .dmg 

(disk image) file and copy the enclosed file to 
your application directory. It is ready to use. 
 
Wings also runs under Windows emulation 
via Virtual PC. 
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1.2 Linux® 
Binaries for Linux®, are now available for download thanks to the efforts of KayosIII. They are 
kindly hosted by waldomac and you can get them at 
 

http://www.waldosworld.org/linux/ 
 
Of course you can still download the Erlang and Wings source and build your own. To do so you 
must download the source code package for both as found at the Sourceforge® project page and 
compile them. 
 

http://www.erlang.org/download.html 
 

The system requirements in order to run Wings3D are;   
1) a computer and operating system that can run Erlang/OTP, and  
2) OpenGL®/Mesa drivers. You will need the following components to run Wings: 

 
 Erlang/OTP, 
 SDL, 
 ESDL, 
 Wings3D. 
 
Download all four packages and compile them in this order; Erlang/OTP, SDL, ESDL, and then 
Wings itself last. 
Here are the complete build instructions for Wings (from the README), assuming that the OTP, 
SDL and ESDL have been built. 
 
1) Set the environment variable ESDL_PATH to the root of your ESDL installation. 
Example: 
 
        # If you use bash or ksh. 
 export ESDL_PATH=/ldisk/bjorn/esdl-0.9.0906 

 
        # If you use csh or tcsh. 
 setenv ESDL_PATH /ldisk/bjorn/esdl-0.9.0906 

 
2) Run a GNU compatible `make'. 
Once Wings has been installed you can start Wings like this: 
 erl -pa $ESDL_PATH/ebin MY_WINGS_PATH/ebin -run wings_start start_halt 

 
where you should substitute MY_WINGS_PATH with the actual path to 
your Wings directory.  
 
Example: 
 Erl -pa $ESDL_PATH/ebin /ldisk/bjorn/wings/ebin -run wings_start start_halt 
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SECTION 2: THE WINGS3D USER 
INTERFACE 

Please note that screen shots may vary as to 
exact layout based on different versions of 
Wings at the time of their capture. Also, 
some screen shots will be done with 
Advanced Menus enabled while most (I hope) 
are done with Advanced Menus disabled. 
Sorry for any inconsistencies this may cause. 

Also note that the Blender camera mode is 
assumed throughout the text unless noted 
otherwise. Keep this in mind while reading, 
especially if you use one of the other camera 
modes. 

 
 
 

 
 

Model by MrChristopher, Wireframe in Wings 3D 
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2.1 General Overview 
Wings3D opens with an empty Geometry 
Workspace at its core. Above the 
Workspace are the Title Bar and Menu Bar. 
Below the Workspace is the Icon Bar and 
the Status Bar. 

The rest of the user interface is accessed via 
context sensitive menus called up via clicking 
the Right Mouse Button over the 
Workspace.  

In the Workspace itself are the three main 
axes which are conveniently labeled X, Y, and 
Z. It is customary to think in terms of X as 
being the right and left, Y the up and down 
and Z the front and back of a model.  

Many of the commands are axis centric in 
operation, working around these global axis 
or around local axes parallel to them. Display 
colors for each axis can be set to your liking 

and they can be toggled on or off at will.  

You will also find A grid which is useful for 
measuring the objects you create. It uses 
Wings Units which is an arbitrary size that 
you can use to represent any scale you want. 
i.e. inches, feet etc…  

On the lower right hand side of the screen 
you will find a small tab. This is used to resize 
the geometry window. This is also useful for 
adding more geometry windows or making 
room for the Outliner and Geometry Graph 
so they don’t cover the workspace. 

The Status bar on the bottom shows what 
options are available, in this case what each 
mouse button will do, and it will also act as a 
tool tip informing you of each items function. 
. 

Figure 1: The Wings3D program window.  
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Figure 2: The Title Bar. 

2.2 The Title Bar 
At the top of the Wings window is the Title 
Bar. It identifies the application by name, and 
if there is a previously saved model open, 
displays the name of the model. At the far 

right of the bar are the standard GUI widgets 
for Minimize, Restore, and Close. 

2.3 The Menu Bar 
Below the Title Bar is the Menu Bar. Here 
you will find options common to Wings in 
general, with a few exceptions. The exception 
is the Objects Menu, which works only on 

Objects (an object is also know as a Body in 
Wings). Each Menu will be discussed in full in 
Section 5, The Wings3D Command 
Reference Guide. 

2.4 The Icon Bar 
There are three sets of Icons above the 
workspace as illustrated here. 
 
The two on the left determine what Display 
Mode your model is in. They are, from left to 
right, Wire-shaded on/off, and Perspective 
on/off. These are used to toggle on and off 
these features as you work. Perspective off, 
also called Orthogonal view, is useful for 
lining an object up to a reference image 
plane. 
 
The next four icons display what 
Edit/Selection Mode you are in. They are 
Vertex, Edge, Face and Body. The red 
highlighting gives you a quick visual key as to 
just what elements are affected in each 

mode and the white outline box indicate 
which mode you are currently in. In the above 
illustration we are in Face selection mode. 
Your Edit Mode will be important when it 
comes to using any of the modeling tools, 
since most tools are presented in context 
sensitive menus within the Workspace. The 
context of those menus is determined by the 
current Edit Mode. 
 
The last two are Ground Plane and 
Reference Axes. These icons are used to 
quickly toggle on or off these features as 
needed.  
 
. 

 

Figure 3: The Menu Bar. 

 

Figure 4: The Icon Bar. 
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2.5 The Status Bar 
At the bottom of the Wings3D Workspace is 
the Status Bar. This is where Wings passes 
messages to you. Keep an eye on the Status 

Bar as you model, for it will give you context 
sensitive help as you go. 

2.6 Dialog Boxes 
Occasionally you will need to enter values via 
keyboard as input parameters to perform 
some action in Wings. This is done via pop-
up dialog boxes. Preferences are entered via 
a large form dialog while numeric inputs for 
modeling commands are done via small pop-
up dialog boxes.  
 
The preferences dialog box comes up when 
you select Preferences, found in the Edit 
Menu. When in the Preferences dialog you 
can click or Tab from field to field, type in 
your preference setting or turn on/off 
toggles with the mouse. If you do not want to 
make any changes after selecting an item 
you can dismiss the sub-menu with the 
Cancel button. Click the OK button to apply 

the changes. To enable all the changes to 
your preferences click on the OK button in 
the main dialog box. If you want to abandon 
all your changes click the Cancel button in 
the main Preferences dialog box to abort the 
changes you have made.  
 
Dialog boxes are also used while modeling to 
allow for numeric entry of parameters. To 
bring up modeling numeric input dialogs hit 
the TAB key after selecting the function you 
want to use. For example, to Move a face by 
1.5 units in X select the face, right click for 
the Face Menu, choose Move, select X and 
then hit Tab. The little dialog box will come up 
and you can type in 1.5 and hit return. 

Figure 5: The Status Bar. Here the status bar is telling us that a left mouse click [L] will select 
an element, a right mouse click [R] will bring up a menu, and a middle mouse click will allow you to 
tumble the object on screen. These instructions will change based on what you are doing and 
what you have selected. 

Models by Mike Gleason. Rendered in Strata Studio 
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2.7 Context Sensitive Menus 
The ease of use of the Wings3D user 
interface revolves around the implementation 
of context sensitive menus, accessed via the 
Right Mouse Button. If you are familiar with 
Nendo®, these will be intuitive to you, but if 
you are a new user, or migrating from 
another modeling system, they bear some 
explanation. The specific context sensitive 
menu that will be presented when the Right 
Mouse Button is pressed over the 
Workspace is dependent on which Edit Mode 
you are currently in, as determined by the 
central icons on the Icon Bar, while some 
element (a vertex, edge, face or object) is 
selected. If the Workspace is empty, or if no 
elements are selected, you will get the 

Primitives Menu. If vertices are selected, the 
Vertex Menu will come up; edges, the Edge 
Menu, faces, the Face Menu; Body (full 
objects), the Object enu. Each of these will be 
discussed in the section titled Context 
Sensitive Menus in Section 5. Suffice it for 
now to say that the Vertex Menu performs 
functions on vertices, the Edge menu on 
edges, etc. Option boxes allow you to specify 
some parameters for an operation. Click 
directly on the box to bring them up. 
Arrowheads indicate that there is another 
pop-up sub-menu for that operation. The 
Square brings up a panel to customize that 
item before it is created. 
 

Figure 6: Contest Sensitive Menus. These are context sensitive menus of the main geometry 
window. These are not to scale in order to show you all the menus. These menus appear when 
the appropriate feature is selected and right clicked on. From left to right; The Primitives Menu 
(when clicking an empty part of screen), the Vertex menu, edge menu, the face menu and the 
object menu. 
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2.8 The Information String 

 
If you have an element of geometry selected 
Wings will display some basic information on 
that element (or elements) in a string at the 

top left-hand side of the workspace. The 
color of this text is set in the Edit | 
Preferences menu via the Text Color 
parameter. If you find this text string 
annoying you can hide it by simply changing 
the text color to match the background color 
of the workspace. I do not recommend this 
course of action since you can glean some 
useful information here. If you select an 
element, a vertex for example, Wings will 
inform you of the Vertex ID and it's position in 
X, Y, and Z. Furthermore, if you select 
another vertex, so that two are selected at 
the same time, it will tell you how far apart 
they are. If you select a single edge it will tell 
you how long that edge is. This can be very 
useful, especially in modeling buildings and 
the like. 
 

2.9 Wings Units 
A Wings Unit (wu) is arbitrary in size and can 
be thought of in terms of any real world units 
desired. The Wings grid is composed of 
squares each 1x1 wu in size. The standard 
Wings cube is cube is 2 x 2 x 2 Wings Units 
in size. If building a model from scratch you 
can arbitarily decide that a wu will represent 
inches, feet, meters or miles; whichever is 
most appropriate for the task at hand.  

It is not uncommon for Wings units and 
other 3D packages units to be vastly 
different in size. Therefore you will need to 
experiment with the import/export sizing 
options to get suitably sized objects on 
import/export. Scaling by 1000, for 
example, brings in a Poser model at a decent 
working scale. 

 

Quick Tip: Working With Wings Units 
When working with many Wings commands 
dragging with the Shift key depressed will 
cause movement to be constrained to whole 
units, while the Ctrl key will cause movement 
to be constrained to tenths of units. Holding 
down Shift + Ctrl keys constrains operations 
to hundredths of a wings unit. While it 
seems the same as the readout – as this is 

only 2 decimal places – it is possible to do 
unconstrained drags and get elements that 
are 3 decimal places when measured, even 
though the read out only shows two. Had me 
tearing my hair out on more than one 
occasion. Where it matters I use Shift + Ctrl. 
Quick Tip Provided by Puzzled Paul 
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SECTION 3: A QUICK START GUIDE 

3.1 Finger exercises to get you started. 
After starting Wings3D from your desktop you will be presented the Wings3D program window 
with an empty workspace. Right click anywhere in the empty workspace and you will be presented 
with the Primitives context sensitive menu, as illustrated in the section above. Move your mouse 
over the Cube menu item. It will become highlighted in blue. Left click on the word Cube and a 
cube primitive will be added to your workspace. Your workspace should look like this. 
Now we will just play around with some of the basic functions so that you can get a feel for how 
the interface works. Once you spend just a few minutes getting the hang of the interface, you will 
be ready to do one of the tutorials that follow. Remember, that when I say to switch to vertex, 
edge, face, or body selection mode that you can do so by either clicking on the appropriate icon 
on the Icon Bar (the four in the middle) or just by pressing the V, E, F or B hot keys on the 
keyboard. Right clicking with an element selected will bring up one of the context sensitive menus 
whereas right clicking without anything selected will bring up the Primitives menu. The Space Bar 
will deselect everything. 
Let's begin by changing to Vertex Selection Mode (click on the Vertex Icon or hit V). You should 
now see your vertices at each corner of the cube (Figure 8.a). Click on the two top left vertices. 

Figure 7: A cube primitive has been added to the Workspace. 
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Note that they become highlighted. They are selected (Figure 8.b). Now right click in the 
workspace. The Vertex Operations menu comes up (Figure 8.c). It presents you with vertex 
specific commands only, thus limiting the amount of confusion possible. This context sensitive 
method of working is considered one of the strong points of Wings3D and leads to very short 
learning curve. Click , or hover, on Move. Note that a side bar menu of Move specific options 
comes up (Figure 8.d). Click on Normal and move the mouse around a little to see what happens. 
Then move it to the right until the distance moved is 1.0 as indicated on the Status Bar at the 
bottom of the Wings window. Left click to end the Move command. Your cube should now look 
like figure 8.e. Hit the Tab key to see a Smooth Shaded view of the modified cube (Figure 8.f). Hit 
the Tab Key again to go back to Shaded Wireframe mode.  
 
If you did not hit the Space Bar, the two vertices should still be selected. In fact you should have 
noticed they were still selected even when we were in Smooth Shaded mode. So now switch to 
Edge Selection Mode (hit the E key). Notice that all the edges that were adjacent to the selected 
vertices are now automatically selected (Figure 9.a). Because Wings3D uses winged-edge 
topology it can keep track of what elements are associated with what. So Wings can carry 
forward selections from mode to mode, which can greatly speed up your modeling. 

 
Now right click in the workspace to bring up the Edge Operations menu (Figure 9.b). Choose 
Bevel from the menu and move the mouse to the right until the Status Bar reads 0.50 then left 
click to end the command (Figure 9.c). Note a couple of things here. Bevel ended and put us into 
Face Selection Mode automatically. See the faces are already highlighted and the active icon is 
now the Face Icon. Wings attempts to end commands by making the elements that it just created 
active on the assumption that since you just made them, you will want to do something with them. 
Not always true, but it's a pretty valid assumption most of the time and can help speed up your 
modeling. 
 

Figure8: Basic Wings navigation.  
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Since we are in Face Mode, lets right click again and bring up the Face Operations menu (9.d). 
Extrude Normal by 0.25 (Figure 9.e). Now Switch to Body Mode (hit the B key or click the Icon). 
The whole object becomes highlighted. Right click to bring up the Body Operations menu and 
choose Smooth. Your object should like like that in Figure 9.f. Hit the Space Bar to deselect it 
then hit the Tab Key to see it smoothed.  Now hit the U key to watch it rotate (Left click to stop 
the rotation). Well, quite by accident we made a fairly reasonable facsimile of a tooth! But the idea 
here was not to build a meaningful model, but to get you used to the Wings3D user interface. You 
should be fairly comfortable with it now and ready to go on to the Dog House Tutorial. 
 

Quick Tip: The Nature of Normals 
Assuming the reader may be new to 3D modeling as well as to Wings3D, it may be useful to 
explain what a normal is and why they are useful in commands such as Move | Normal. Simply 
put, a Normal is a vector that extends outward perpendicular to a graphic element. Faces, edges 
and vertices all have normals. So, when we move a face along its normal we will move it out along 
a line that extends from its center outward, like a flag pole sticking up from the ground. 

Figure 9: Working with the Wings interface. 
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3.2 Your First Real Model; a Dog House. 
If you still have your finger exercise up, do a File New. Don't bother to save the tooth, unless you 
really want it. Now let's build a dog house. 
 
Start with a primitive cube. Select the lower and upper edge on one of the sides. Then Connect 
them (remember to right click to bring up the Edge menu). Hit the Space Bar to deselect the new 
edge. Repeat the operation on the opposite side of the cube. You should have something similar 
to that shown in Figure 10.a.  
 
Select the three vertical edges on one of the sides. Connect. Hit the Space Bar to deselect the 
new edge. Repeat on the other side. You should have something similar to that shown in Figure 
10.b. 
 
Move the horizontal mid-edges up in the Y direction on both sides by 0.50 units. Then Move the 
vertical mid-edges forward in the Z direction on both sides by 0.50 units. You can see the units 
change in the Status Bar at the bottom of the Wings window, below the Icon Bar. Simply stop 
dragging when the value reads 0.50 and left click the mouse. You should have something similar 
to that shown in Figure 10.c. 

  
 

Figure 10. Roughing in the basic form. The top and bottom edges have been Connected 
in (a). The new edge and the two side edges were then Connected in (b). Do this on both 
sides of the model. In c the edges have been Moved. Do both sides of the model at the 
same time to ensure symmetry. In (d) the sides have been Extruded. The vertices on the 
front face have been Connected in (e). In (f) the new edge and the bottom edge were Cut 
by 3 and the resulting vertices then Connected. 
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Select the two large faces, one on each side, and Extrude Normal by 1.0. You should have 
something similar to that shown in Figure 10.d. Then Select the two vertices on the front face and 
Connect them as shown in Figure 10.e. Select the two long edges on the front face and Cut by 3. 
Connect the resulting vertices. You should have something similar to that shown in Figure 10.f. 
 
Select the front faces of the side sections and Inset some windows as seen in Figure 11.a 
Move the front three edges that run horizontally across the front of the main cube down in Y by 
0.50 to square up the door as shown in 11.b. Then select the two windows and Scale them down 
in Y by 0.50 units to square them up as well. You should have something similar to that shown in 
Figure 11.c. Select the door, windows, and the three floor faces as shown in 11.e. Now Intrude 
to hollow out the shell of the dog house. Figure 11.f shows the results of the Intrude operation. 
The thickness of the walls is determined by how much you move the mouse while Intruding. 
 

Figure 11. More basic construction. New faces have been Inset in (a). The three edges 
on the front face were then Moved down in Y (b) to resize the door face. The windows are 
then resized in c. Select all the faces that will be used for the Intrude command in (e) and 
Intrude. The results of the Intrude are shown in (f). 
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Select the two edges that go from the side sections to the main roof and Dissolve them (Figure 
12.a). Switch to Vertex Mode. Select the two left over vertices on the roof lines and Collapse 
them (Figure 12.b). Then select the top face and Inset by 75% (Figure 12.c). Now Move the inset 
roof face up in the Y direction for 0.50 units (Figure 12.d). Now Inset the top face outward by 
30% then Extrude it up in Y by 0.25 units (Figure 12.e) and then Scale it down Uniform by 90% 
to form a little roof cap. The house should resemble that shown in Figure 12.f.  
 

Figure 12. Building the main roof. Dissolve the edges (a) and Collapse the vertices (b) 
that disrupt the roof face. Then Inset the roof c. Move the center face up in Y (d) then 
Inset outward and Extrude Y to form the roof cap(e). Then Scale the top of the cap (f). 



WINGS3D USER MANUAL  Section 3: A Quick Start Guide 

 DRAFT 1.6 23 

Select the top faces of the side sections and Inset outward by 40% (Figure 13.a). Then Extrude 
Normal up by 0.10 units (Figure 13.b). Switch to Edge Mode. Deselect the front and back edges 
with the mouse. This will leave the inside and outside edges still selected as in Figure 13.c. (I just 
rotated the house so you can see the back side and see that four edges remain selected.) 
Connect the side edges (Figure 13.d). Move the new edges up in Y 0.53 units to form gables. Hit 
the Space Bar to deselect everything and switch to Vertex Mode. Then select the vertices on the 
outside of the two gables and Scale X by -25% to bring them in as seen in Figure 13.e. Then 
Connect the vertices on the top outside edges on the sides of the gables. 

 

Figure 13.The side roofs. Select the two side roofs and Inset outward (a) and then 
Extrude Normal up (b). Select the four edges (two on each roof) and Connect (c). Move the 
new edges up (e). Switch to Vertex Mode and Scale the two outer most vertices in X to 
form the gables (f).  



Section 3: A Quick Start Guide  WINGS3D USER MANUAL 

24 DRAFT 1.6  

Connect the front side top edges (Figure 14.a). Then select the two lower edges of the front top 
and Connect them (Figure 14.b). Switch to Vertex Mode (Figure 14.c) and Scale the vertices 
down in Y to bring the two lines close together and then Move them down in Y to bring them 
closer to the door (Figure 14.d). Select the two edges we just positioned (Figure 14.e) and Cut 
them by 3, then do a Connect on the resultant vertices (Figure 14.f). Scale them apart in X by 

40% (Figure 14.g). Select the new face (Figure 14.h) and Extrude it Normal by 0.5 (Figure 14.i). 
 
Select the top back edge of the porch roof (Figure 15.a) and Cut it by 2. Connect the resulting 
vertex with the two front top corner vertices as show in Figure 15.b. Move the back center vertex 
up in Y by 0.5 (Figure 15.c). Now dolly the camera so that you can see the underside of the porch 
(as in Figure 15.d).  
 
Connect the bottom side edges of the porch roof (15.e). Move it forward in Z by 0.15 units 
(15.f). Select the front and back bottom edges of the porch roof too. Cut all three edges by 3 
(15.g). Connect the vertices (15.h). Scale them apart in X 130%  to form small square shaped 
faces at the front bottom corners of the porch roof (15.i). Now select the two intersecting 
vertices and Bevel to 0.07 units (15.j). 
 

Figure 14. The porch overhang. Connect the side edges of the top front face (a) and 
then Connect the lower set again (b). Select the vertices and scale them down in Y to 
bring the edges closer together c. Then Move them all down closer to the door (d). Cut 
the edges by 3 (e) and Connect the resulting vertices (f) and scale them apart (g) to form 
a face that will become the porch roof (h). Then Extrude that face (i). 
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Select the resulting edges and Cut by 2 (15.k). Scale the resulting vertices from one side Uniform 
by 40% to form a roundish face (15.l). Now select the four vertices on the other side and do an 
Edit | Repeat Drag to form an exact copy of the rounded face on the other side of the porch. 
Select the two round faces and Extrude Y by -1.10 units which will make them even with the 
bottom of the house.  

 

Figure 15. Under the porch. Cut the back edge of the porch roof by 2 (a) and connect 
that vertex up with the two at the top front corners (b). Then Move the center vertex up in 
Y (c). Now roll the house over so that you can see the underside of the porch (d). Connect 
the two side edges (e) and Move the new edge towards the front. Select the three long 
edges (g) and Cut by 3 and then Connect the resulting vertices (h). Bevel the intersecting 
vertices (i). Then select the edges of the new boxes and Cut by 2. One one side only, Scale 
the new vertices Uniform to form a circle (j). Then use Repeat Drag (k) to create another 
circle (l) on the other side of the porch. 



Section 3: A Quick Start Guide  WINGS3D USER MANUAL 

26 DRAFT 1.6  

Switch to Body Mode and select the house by clicking on it. Then switch to Edge Mode and all the 
edges will be selected. Right click to bring up the Edge Operations menu and set Hardness to 
Hard. 
Pick faces and set materials to your liking. Select all the roof top faces. Right click for the Face 
Operations menu and choose Set Material. You will be prompted for a material name. Call it 
Roof. The Material Editor will come up. Change the settings until you get a roof color you like on 
the preview globe on the left. Then click OK.  

 
While you can see the materials on the shaded wireframe in Workmode you can get a better idea 
of how things will look in Smooth Shaded Mode.To see the results deselect the roof faces and hit 
the Tab key for a shaded preview. You should see the new roof color. Now repeat material 
assignments as you did for the roof until your dog is happy (Figure 16.c). 
 
Save the model. Optionally, Export the model into one of the formats your renderer can accept 
and render the dog house to see how it turned out. Here is mine (Figure 17) 
 

 

 

 
 
 
 
 

 

Figure 16. Completing the project. Select the two circles (a) and position your model so 
that you can see it from the front with all the bottom edges lined up (b). Then Extrude Y to 
create the columns. After assigning materials your model should resemble the one 
depicted in c. Remember to hit the Tab key to see the colors in Smooth Shaded mode. 

Figure 17. The dog house, rendered in Vue 
d'Esprit®. 
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3.3 Creating A Hand  
(an intrinsically organic shape) 
Now that you have the basics down you can try to model something more challenging than a dog 
house. Wings3D uses a modeling technique know as subdivision surfaces, a technique favored by 
many to create organic, or natural world, type of models. So it seems fitting that for our second 
model we attempt to create an organic type model; in this case we will attempt a hand. So do a 
File | New to get a fresh slate and put a cube in your work area. Since hands are not cubes, let us 
begin by scaling the cube into a flatter shape, more conducive to hand building. Switch to Body 
selection mode by clicking on the Body icon on the icon bar or by hitting the B key. Then click on 
the cube to select it.  

  
 
 
 

Figure 18: Cube preparation. A selected object becomes 
highlighted in the current Selection Color as set in the user's Color
Preferences. Here the cube is selected. 
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Now that the cube is selected we can change its basic shape via some of the Body functions 
found in the Body Operations menu. With the cube still selected right click out in  the open 
workspace somewhere to call up the Object enu. A menu will pop up with all the available 
functions for full body manipulation. 

  
 
 
 

Figure 19: A refresher. With the cube selected, right click in the
Workspace to bring up the Object Menu. Only operations relevant to
object manipulation are available. 
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Hover over Scale and a sidebar menu will come up with things you can do regarding the Scale 
function.  

 
 
 
 

Figure 20: Working with the context sensitive menus. Menu 
items with side arrows have associated Side Bar Menus. Selecting 
the menu item, in this case Scale, will bring up the Side Bar Menu.
Here we select Scale – Z so that we can make the cube thinner. 
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Click on Z to limit changes in scale to the Z axis and then drag your mouse to the left (the -Z 
direction) to make the cube narrower. 

  
 
Left click to end the Scale operation.  
 
 

Figure 21: A palm is born. The cube has been adjusted to form the
palm of our hand model. 
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3.4 Adding Detail 
Now we will add some fingers and a thumb to the basic hand block. Begin by clicking on the Edge 
Mode Icon at the bottom of the workspace to switch to Edge Selection Mode. Notice that all the 
edges become highlighted, because they were derived from a previously  selected object. Hit the 
Space Bar to deselect everything. Now select the top two edges, as illustrated below. Right click 
in the workspace to bring up the Edge Operations menu and choose Cut and then 4 from the side 
bar menu to cut the top edges into four equal parts. Notice that upon completing the Cut 
operation you are automatically switched to Vertex Mode with the affected vertices pre-selected as 
seen on the top right frame of the picture below. Right click in the workspace to bring up the 
Vertex Operations menu and select the Connect function. New edges will snap into place, as seen 
in the bottom right frame below, thus forming four new faces on the top side of the hand block. 
These will eventually become the base faces for our fingers.  

 
 
 

Figure 22: Cut in the finger nubs. Select the top two edges (top 
left). Right click for the Edge Menu (top middle) and Cut by 4. This
creates new vertices (top right) which are pre-selected. Another right 
click brings up the Vertex Menu (bottom left) where we can Connect 
the vertices to create four new faces (bottom right). 
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Now select the two side edges of the hand block. Right click in the workspace to bring up the 
Edge Menu and select Connect. A new edge will be created that connects the two sides, thus 
breaking the side face into two equal faces while leaving the new edge in the selected state. While 
it is still selected right click for the Edge Menu again and Move in the Y direction just a bit. Hit the 
space bar to deselect everything and then select the two lower vertical edges on the side and 
Connect them. Slide the resultant edged down with the Move Y function so that it is just above 
the base of the hand. We now have faces in place that can form the base of the four fingers and 
the thumb. 
 

 
 
 
 

Figure 23: Cut in the thumb nub. Select the two side edges (top 
left) and Connect them. Move the resultant edge (top middle) down in
Y via the Edge Menu Move Y function (top right). Then select the two
lower edges (bottom left) and connect them. Then using the Edge
Menu Move Y function again (bottom middle), move the new edge
down along Y to form the base face that will become the thumb. 
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Next we will use the Face function Extrude to create some basic fingers. Switch to Face Selection 
Mode by clicking on the Face Icon at the bottom of the Workspace. Then click on the four faces 
that will form the base of the four fingers. Right click for the Face Operations menu and select 
Extrude and then select Y. Move your mouse to the right to extrude the faces up a bit then left 
click to end the extrusion. Notice that the end faces remain selected, facilitating another extrude. 
So do another, shorter, extrusion. This will later form knuckles. Then carry on with the extrusions 
as illustrated in Figure 24. You do not have to constantly right click to bring up the context 
sensitive menu, however. Wings has a Repeat command, accessed by simply hitting the D key on 
your keyboard. It can save you quite a bit of time if you are doing many of the same types of 
functions over and over, as here with the finger extrusions. 

 
 
 

Figure 24: Extrude the fingers. Select the finger base faces (top 
right) and Extrude in Y a little (top center). Do a shorter Extrude for 
some knuckles (top left). Then carry on as shown in the lower 
frames. 
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To add a thumb we will do another set of extrusions, but we don't want the thumb to stick straight 
out from the side of the palm, so we will also use the Rotate function. Select the face we created 
earlier for the base of the thumb and do a Extrude in X. By now you should have gotten the knack 
of the context sensitive menus, so I will stop telling you to right click in the Workspace to bring up 
the Face Operations menu... to help speed things along. The extruded face will still be selected, so 
now do a Rotate in Z. Move your mouse back and forth to see how the face will rotate about the 
Z axis, rotating up when moved to the right, and rotating down when moved to the left. Rotate 
the face up until it looks about like the illustration in Figure 16. Left click to stop rotating. Now do 
a series of extrusions. This time we will Extrude Normal rather than along one of the primary 
axis.  Extruding in the normal simply means to move the extrusion along a vector perpendicular to 
its plane. Then it is simply a matter of doing two more extrusions and we have a very crude model 
of a hand. 

 
 
 
 
 

Figure 25: Extrude the thumb. Extrude the base thumb face (top 
left). Then Rotate the end face about the Z axis (top right). Extrude in 
along the Normal three more times (lower left) to complete our 
rough-in of a hand (lower right).  
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3.5 Finishing It Off 
This hand, admittedly, looks very crude. There is a little we can do to make it look better while 
introducing you to some more Wings3D tools and concepts. So let's take the hand model just a 
little bit further before calling it quits. 
 
We want to add some additional detail to make the hand look more natural. But first, let's see 
what it looks like as is, in the smooth shaded mode and again with one Smooth applied to it. I will 
frequently do a Smooth operation while modeling just to get a feel for how things are going, then 
Undo to continue modeling. You may find that technique useful too. And a Smooth will help you 
isolate and fix problems in your model caused by bad geometry that some times lurks in 
unexpected places. 

 
Hit the Space Bar to make sure nothing is selected. Now left click on the Smooth Shaded Icon 
(the rightmost icon on the left set of  icons) on the Icon Bar to see what our un-smoothed hand 
looks like. Yikes! Hit the Tab key to leave Smooth Shaded Mode. Note that you can enter and leave 
Smooth Shaded either way, via the icons or via the Tab key. Now select the hand again and do a 
Smooth. Hit the Space Bar to deselect the hand and then hit the Tab key to see the smoothed 
hand in smooth shaded mode. 
Not very impressive. 
 

Figure 26: The Smooth operation. The hand in Flat Shaded Mode 
(top left) and in Smooth Shaded Mode (top middle). With the hand 
selected do one Smooth operation (top right). You can see the 
results of the Smooth in Flat Shaded Mode on the bottom image set 
here; the left one while the hand is still selected. On the far right is a 
smooth shaded view of the hand following the Smooth operation. 
While it looks much more "organic" it still appears to be far from 
natural. 
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Now undo the smooth by selecting the Undo function from the Edit Menu. Do this as often as 
needed to get back to the un-smoothed version of the hand. We will now attempt to make it look 
at least a little more natural by adding some finger nails, some knuckle bumps, and some 
tendons. To save space and since you should have a pretty good feel for the basic operations by 
now, I will not take you though the process of adding these details step by step. Rather, I will 
present you with a set of sample objects in Figure 27 and tell you in general what I did to get the 
details you see there. I've made the screen shots here a little bigger so that you can see more of 
the detail. So take a moment to study the edges as they progress in the picture below. 
 

Quick Tip: Overlaying the wireframe on a smooth shaded view. 
Some people find it very useful to overlay the wireframe on a smooth shaded view of their model. 
This serves two purposes; first it helps them find surface anomalies while at the same time being 
able to see what edges may be the culprits, and second it gives new modelers a sense of how 
edges and edge loops affect the overall form of the model. To get the wireframe on the smooth 
shaded view simply hit the Tab key to get the smooth shaded preview of the model then hit the W 
key to overlay the wireframe. Note that you can change the color of the wireframe in the Edit | 
Preferences menu.  
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In the top portion of Figure 27 above I added more details by doing a series of Connects. One set 
of Connects was done to create a loop that separates the hand front to back. Then four loops 
were created the same way to completely encircle the hand down the length and each finger and 
into and around the palm. Then another another set of edges was created to run from  the index 
finger tendon up the side of the thumb, and back down the other side. Then to create more of a 
knuckle shape, the vertices at the front and back of each knuckle were Scaled in Y to spread 
them apart thus creating the diamond shaped areas. 
 
In the bottom section of Figure 27 I added yet more detail. To add detail to to knuckles I Dissolved 
the edges on the inside of the diamonds (front and back) and then Inset them a bit to create inner 
diamonds. Then I used Connect on vertices to create the details you see here. 
 

Figure 27: Adding details. Detail has been added (top) by selecting 
edges or vertices as needed and Connecting them to rough in the 
knuckles and tendons. Then more detail was added (bottom) adding 
more edges via Connects and then Moving vertices to form knuckle 
bulges and round out the palm. Finger nails were created by selecting 
faces and Extruding Region. 
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Then I Moved the inner vertices out to form bumps on the backside of the fingers and in to form 
creases on the inside of the fingers. Then I selected the faces for the finger nails (four per nail by 
the way, not just two) and did an Extrude Region slightly into the fingers. Then I scaled down the 
region just a bit and then did another Extrude Region to raise the nails just past the level of the 
skin. Of course I did all this stuff for the thumb too.  
 
Now my attention turned to the hand itself. I added four more edge loops that surrounded the 
hand. Then I added edges to form the V shape around each of the tendons. This allowed me to 
Move the edges for the tendons out so that they bump up a little. Of course on the palm of the 
hand I Moved them into the hand a bit to form creases. Then  I went about the outside of the 
hand and in between the knuckles and tried to round things up a bit by moving vertices. It's not 
looking too bad at this point, in fact, the hand is almost complete. 
 
Figure 28 below shows some final detail I have cut into the palm of the hand, the life lines, as 
used in palm readings. They were created by doing some Connects on the edges to include the 
curve of the lines. Then the lines were Beveled to turn them into double lines and then the 
vertices were Moved into the hand to create the necessary creases. This completed the modeling 
portion of the hand. Be we are not done. In the bottom half of Figure 28 you can see that I have 
assigned colors to the hand. It is important for you to assign colors to your models before you 
consider your task complete because each different color assignment can be used to great effect 
in subsequent paint and rendering programs. 
 
In the bottom half of Figure 28 you can see that I have made two distinct color assignments; one 
for the skin of the hand, and one for the nails. later when I create a texture map, I will be able to 
pull the model apart and arrange the parts nicely in my texture mapping program of choice 
because I did this. In fact, if I were smart, I would have assigned a different texture to the front 
and back of the hands so that they could be easily isolated for painting. So, to make these color 
assignments simply select the faces to be assigned a color and then use the Face | Set Material 
operation. You will be presented with a pop-up box with New, Default and Hole as choices. Select 
New and you will be prompted for a material name. Give the faces a short but logical name. Skin 
and nails come to mind for me here. The Material Editor will come up, as shown in Figure 29 
below. 
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Click on the little boxes to bring up sub-menus (Figure 29a) for setting the actual values for the 

Figure 28:The hand completed. Final detail cut in (Top) and with 
colors assigned (Bottom). 

Figure 29: The Wings Material Editor. 
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first four parameters. This is done via entering a number in the numeric entry fields or by using 
the slider bars.  
You can set the diffuse, ambient, specular, 
and emissive colors as well as the 
shininess and opacity of the selected faces.  
The effects of your changes will show up 
interactively in the color box to the left. 
When you click OK the effects will be 
reflected on the ball on the left side of the 
material editor window. Once you are happy 
with your settings click the OK button on 

the material editor window. You don't really need to get too fancy here, especially at first, so just 
make a color you like for skin and click OK. 
 
The fastest way to do this is to set up the largest material first by selecting the object then 
switching to Face Mode so that all faces are selected. Then assign all the faces that color, in this 
case, skin. After hitting OK in the Material Editor you can then select the nails and do another Set 
Material, and then dream up you nail color. Say OK again. Then  hit the Space Bar to deselect 
everything so you see your creation in full color. Don't forget to Save your model before quitting, 
and you may also want to Export it into a format that your rendering program can read. 
 
That should give you the basics for organic modeling in Wings since a hand is definitely an organic 
subject. Not to say my model is a particularly good example of if. It is not a lifelike hand at all. But 
considering it is the first Human hand I ever modeled, it did not turn out too badly. And since 
subdivision surface modeling is known to be particularly good for organic type models this was a 
good exercise. Now you can try something else organic. I recommend you do what I did for the 
hand. I found some cages (finished hands in wireframe mode prior to smoothing) and analyzed 
them to see where the artists had placed the edges and then tried to emulate their examples. My 
thanks to Mike Rickard for providing the hand model that inspired this one. His was much better, 
but I needed to do this from scratch so that I could adequately describe what the steps were. But 
there are plenty of cages posted out on the web, simple screen shots of non-smoothed models. 
Use them as your guide until you develop a style of your own. 

Figure 29a: An example of the Material Editor 
sub-menus. 

Model by David Benton. www.davidbenton.net 
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SECTION 4: THE NATURE OF  
SUBDIVISION MODELING 

4.1 Subdivision and Such 
Wings is a polygon modeling system with an 
implementation of subdivision surfaces as 
one of its core functions. Because of that it, 
and other modeling packages that use 
subdivision surfaces, is often referred to as a 
subdivision modeler and the type of modeling 
done with it as subdivision modeling. This is 
often also called box modeling since most 
models start out as a cube primitive. There 
are fundamentally three types of subdivision 
surface styles available for polygon modelers; 
facet, smooth, and metaform1. Wings has 
the ability to do facet and smooth, but 
currently does not support metaform. Facet 
smoothing simply subdivides the model 
without doing any smoothing. Smooth does 
the subdivision and smooths the model, 
making it look much more organic. Which is 
why subdivision modeling has become so 
popular for organic modeling. Figure 30 
illustrates the difference between facet and 
smooth subdivision on a simple cube. 

 

                                           
13D Modeling and Surfacing by Bill Fleming. 

To achieve the facet type subdivision all the 
edges on the left hand cube were made Hard 
prior to the Smooth operation. This kept the 
cube from smoothing out as the one on the 
right did. Smooth subdivision is one of the 
strong features of Wings as it lends itself 
quite nicely to very organic looking models. 
 
Metaform subdivision is not supported by 
Wings. Briefly stated, metaforms shows the 
smoothed model with the un-smoothed cage 
floating about it. Wings currently does not 
fully support this modeling method, but it is 
moving in that direction. To get a feel for it 
create an object, press the Shift Tab key 
combination to smooth preview it, and then 
hit the W key to lay the wireframe on top of 
it. This is similar to metaforms, but with 
metaforms you would be able to specify the 
number of smooth levels, and manipulating 
the un-smoothed cage would give immediate 
feedback to the smoothed model so you 

could see how changes will 
affect the final form. But since 
Wings does not yet support this 
feature we will not spend any 
further time discussing it here. 
One of the mistakes new 
modelers often make is 
subdividing their models too 
soon, and/or too often. Our 
hand exercise in the previous 
section provides an excellent 
example of what I mean. Take a 
look back at Figure 26, then 
look at Figure 28. While neither 
hand looks all that great, you 
will have to admit that the hand 
in Figure 28 is much better 
than the one in Figure 26. Why 
is this? Because the modeler 
(me) in Figure 26 tried to rely 
on smoothing to make his hand 

look organic way too soon in the modeling 
process. Whereas the modeler (me again) in 
Figure 28 took the time and effort to add in 

Figure 30: Subdivision. The cube on the left was facet 
subdivided while the cube on the right was smooth subdivided. 
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critical detail by connecting vertices and 
edges, tediously moving points up, down, in 
and out until the hand looked much more 
natural without ever even doing a smooth. 
 
When modelers smooth too soon and don't 
get the organic form they were hoping for 
they then often resort to smoothing again, to 
make it look well... smoother. Some people 
will smooth a model three or four times to 
try and get it to look right. This is almost 
always a mistake. It creates very bloated 
models, high in polygon count, which devour 
lots of memory needlessly. If you take the 
time to hand craft in details, then one 
smooth is likely to give you the results you 
want, the model will be much more efficient, 
and it will most likely look better too. 
Remember, that hand in Figure 28 was 
never smoothed, not even once. 
 
Often a model will loose desired edges and 
creases when it is smoothed. Fortunately 
there are a couple of ways to keep sharp 
details even on a smoothed model. You can 
use Bevel on corners to add a slight chamfer 
which will help preserve the detail. You can 
also select the necessary edges and set 
them to Hard. Be sure the model export 
format and the rendering engine you intend 
to use supports Hard edges, or you may not 
get the results you expected. Bevels on the 
other hand will always do the trick. 
 
Another reason to use Bevel instead of hard 
edges is that they help show off detail. It 
seems that sharp edges don't show 
specularity well, making details hard to see2. 
By giving man made objects softer edges via 
Bevel, it increases their specularity, thereby 
drawing out the detail that would otherwise 
be lost. Some on-line model stores will not 
even accept models for sale that do not use 
beveled edges to maintain detail, so avoid 
hard edges if you can. 
 
And as with smoothing, some people tend to 
Bevel too soon in the modeling process. It 
should be one of the last things you do, 
unless you are using it to create new base 
geometry. The reason is that it over 
complicates your model, forcing you to 

                                           
23D Modeling and Surfacing by Bill Fleming. 

manipulate many more elements than you 
otherwise would have had to deal with had 
you not beveled too soon 

Model by Erin McClellan 
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4.2 The Nature of Edge Loops 
Edge Loop is a term you will see used often 
in polygon modeling circles. It is often 
confusing to new users just what edge loops 
are and what their significance to modeling 
is. Edge loops can be thought of in two 
senses really; the modeling structure that is 
an edge loop, i.e. the physical set of edges 
that connect one edge to the another in 
series; and in the aesthetic sense, the 
controlling elements that define the overall 
form of the item you are trying to model.  
 
In the first sense they are important to 
Wings if for no other reason than if you 
maintain them well you can breeze up and 
down the edge loop chain with the F3 and F4 
keys to do all sorts of tweaks and 
adjustments in no time. Let them fall apart 
and you'll be selecting things manually by 
hand constantly to make such adjustments.  
 
But it's deeper than that. It has to do with 
how the overall form of the model will 
eventually turn out; whether or not it flows. I 
am told that Bay Raitt first coined the term 
as a way to create and maintain overall 
aesthetic control over a model, to use them 
to mimic the structure of the object, such as 
muscles3. There is a whole section on the 
use of edge loops in an article written by Bay 
Raitt and Greg Minter located at 
http://www.izware.com/news/indexa446.h
tml. I suggest you read it in it's entirety. 
 
So you can see that there are edge loops 
and there are edge loops. What I mean by 
that is that there are the physical loops 
themselves, composed of a series of edges 
all joined together at non-pole intersections, 
and there are the edge loops that define the 
form and nature of your model, as Bay Raitt 
describes in his excellent treatise. Learning 
about the former is relatively easy and is 
necessary in order to develop the latter. But 
the real power and beauty of edge loops is in 
the latter, on how they control and define the 
form and detail of the model. Here is where 
the true art occurs. 

                                           
3Digital Sculpting Techniques by Bay Raitt and Greg 

Minter © Nichimen Graphics, 1998. 

 
I am capable, I hope, of describing the 
technical nature of edge loops. As far as the 
artistic use of them, well others will have to 
step in. And, most likely, you just need to 
practice, practice, practice. And keep an eye 
out on the on-line forums for few words of 
enlightenment from master artists like Mr. 
Raitt too. 
 
As stated before, physical edge loops are a 
series of edges joined together at non-pole 
intersections. A non-pole intersection is an 
intersection of four edges at a given vertex. 
This is why quads help maintain edge loops, 
they help minimize poles. The edges that 
encircle an arm are edge loops. But if you 
look at the illustrations in Mr. Raitt's article, 
you will see there are other more important 
loops involved in the arm that link it to the 
chest and beyond. But that gets more into 
the artistic aspect, which I am not well 
qualified to discuss. So, back to the physical 
world. 
 
In Wings, there are tools that let you take 
advantage of edge loops in your modeling. 
You can use Loop Cut to cut off parts of the 
model when needed. You can select by Edge 
Loops and by Edge Rings (the lateral 
connecting edges between two loops), and 
then work with that selection. You can use 
the F3 and F4 keys to march up and down a 
chain of edge loops to do rapid model 
adjustments. And of course there is the all 
important central edge loop. 
 
The central edge loop is important if you 
want to use Mirror or Virtual Mirror to 
speed up your modeling. If you maintain your 
central edge loop, the loop that runs entirely 
around the long axis of your model, then you 
will be able to model on one half of the 
model, Loop Cut off the other half, and then 
Mirror, which will cut your modeling time in 
half. By maintain, I mean to keep the edges 
straight as an arrow true, and to not have it 
interrupted by poles. The first point is an 
absolute requirement, or very strange things 
will happen when you Mirror. You can work 
around the second point. If when you go to 
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select the loop it only partially encircles your 
model because of pole interruptions, you can 
manually select other parts to get a full loop 
for the Loop Cut operation. 
 
Keep in mind that quads (faces with four 
edges) do not ensure the absence of poles. 
To demonstrate this, create a cube and 
smooth it once. Now select an edge one level 
down from the top vertex. Do a Select | 
Edge Loop. The selected loop will not run all 
the way around the object, despite the fact 
that it is made entirely of quads. Examine 
where it stopped and you will see that there 
is indeed a three edged pole present where it 
stopped (Figure 31). Connect that vertex to 
the top most vertex (thus creating two 
triangles) and try the experiment again. The 
edge loops now runs on longer, despite the 
fact that there are now triangles in the 
model. Why? Because there are now four 
edges at that intersection; you have 
eliminated one pole, which was not 
necessarily a good thing to do 

 

. 

Figure 31: Edge loops and poles. On the left you can 
see where a pole stops an edge loop from encircling 
the object. By inserting a new edge the loop can 
continue on a little further. The edge loop at the center 
of the object does completely encircle the object 
because it encounters no poles. On the right you can 
see an example of Edge Rings, shown in pink. 

Model by Erin McClellan. Note the use of multiple windows. 
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4.3 Winged Edge Topology 
One of the reasons Wings works so well with 
edge loops and edge rings is the fact that it 
is based on a topological data structure; 
winged edge topology. Winged edge topology 
is a method that mathematically defines all 
elements in a model by their relationships to 
other elements of the model. This is done by 
a set of tables; specifically face, edge and 
node tables. In Figure 32 I have selected 
one face (Face 71) and then switched to 
Edge Mode to select its component edges. 

The Status Line of Wings tells us that Face 
71 is encircled by edges 9, 16, 70 and 72. 
(Note that newer versions of Wings place 
this information in a string at the top left of 
the workspace.) It only knows this because 
the winged edge topology exists to provide 
the information.  

 
 
Similarly, if we had just selected Edge 72 and 
then done a Edge Loop selection, Wings 
would have know to select edges 60, 68, 
28, and the others on the back of the model 
that we can not see, to complete the loop. 
For a more detailed description of the winged 
edge data structure you can read The 
Winged Edge Data Structure by Dr. Ching-
Kuang Shenefound here: 
http://www.cs.mtu.edu/~shene/COURSES
/cs3621/NOTES/model/winged-e.html 
 

It is well beyond the scope of a User's 
Manual to get into a thorough discussion of 
the winged edge data structure. It is enough 
to know that Wings is based on this data 
structure and it is used to make and 
manipulate selection sets very rapidly. 
 
You can also find winged edge topology 
illustrated from a geographic point of view 
here: 
http://www.bequia.swinternet.co.uk/edgeex
.html

 

Figure 32: Basic topology. Because 
of the winged edge topology of the 
model each element knows its 
relationship with all adjacent elements.

Model by Scott Riding. Rendered in 3D
Studio Max 4 
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SECTION 5: THE WINGS3D COMMAND 
REFERENCE GUIDE 

5.1 The Main Menu 

 
 
The Main Menu consists of logically 
organized functions that are generally global 
in nature throughout Wings3D, that is they 
apply to vertices, edges, faces and objects or 
general environmental settings such as user 
preferences and camera manipulation. The 

exception to this general rule is the Objects 
Menu, which contains functions relevant to 
objects only. The Main Menu items include 
File, Edit, View, Select, Tools, Objects, and 
Help. Each of these will be covered in this 
section individually. 

 

5.1.1 The File Menu 

File Menu – General 

The File Menu contains file handling options, 
most of which are common to almost all 
applications, but some warrant a little 
discussion. Each option is described in its 
own section below. 

File | New (Ctrl-N) 
Default when starting the program, giving 
you a clear workspace to work in. When 
invoked later Wings will ask if you want to 
save your changes with the standard Yes, 
No, Cancel options. If you answer No 
Wings3D will delete all objects in a current 
workspace. 

File | Open (Ctrl-O) 
Will load a previously saved .wings model into 
the workspace. When invoked, Wings will 
ask if you want to save your changes with the 
standard Yes, No, Cancel options. If you 
answer No Wings3D will present you with a 
File Open dialog box. You can then navigate 
to your file and load it by typing in the name 
or double clicking on it from the list of 
available models. If you cancel at this point, 

Figure 33. The main menu bar. 

Figure 34: The File Menu. 
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Wings will keep what was in your workspace, 
otherwise all objects in your workspace will 

be deleted before the requested file is 
opened.

 

FILE | MERGE (Ctrl-L)  
Adds the contents of another .wings file to 
your current scene. When invoked, the 
Windows file open dialog appears. By default, 
it is set to add a .wings file, but the option all 
files is available. The "All Files" option will only 
load a native Wings file such as one with the 
wrong extension (or no extension). Therefore, 
trying to bring in anything but a wings file 
returns the error message: 'Read failed: no 
such file or directory" as this command is for 
loading native Wings files only. One handy 
use for the File | Merge command is to load 
up a previously saved set of lights. If you 
create a lighting environment you are 
particularly fond of delete all the non-light 
objects from the scene and do a Save As. 
Call it something like lights.wings. Then after 
doing a file new you can merge the lights into 
your current scene. Note that File|Import 
implicitly always merges if you want to add an 
non-native format model to your scene. 

File | Save (Ctrl-S) 
Saves the current workspace as a .wings file. 
If the model is new, a Save File dialog box will 
come up allowing you to specify the path and 
file name to be saved. If it is a previously 
existing file, it will save to that file, 
permanently incorporating any changes you 
have made since loading it. 

FILE | SAVE AS (Ctrl-Shift-S)  
Allows you to save the current workspace as 
a .wings file under a new file name. A Save 
As File dialog box will come up allowing you to 
specify the path and file name to be saved. 
This can save hours of labor, being 
particularly useful whenever you either come 
to a point where undoing will become a 
problem if further work does not pan out, or 
at a point that you want to come back to, for 
expanding in a different direction altogether. 

FILE | SAVE SELECTED  
Allows you to save the currently selected 
object or objects in the workspace as a 
.wings file under a new file name. A Save 

dialog box will come up allowing you to specify 
the path and file name to be saved. 

FILE | REVERT 
Clears all work done since last save and 
restores last saved. It does not clear the 
Undo history. The idea is that you should be 
able to undo a Revert if did it by mistake. 
Thus there is no question asking for 
confirmation. 

File | Import 
 Nendo® (.ndo) 
 3D Studio (.3ds) [import scale] 
[export scale] [ok] [cancel] 
 Adobe® Illustrator (.ai) 
 Wavefront® (.obj) [import scale] 
[export scale] [ok] [cancel] 
 
Import files of selected format in current 
project. Wings supports the importation of 
Nendo® (.ndo), 3DS Max® (.3ds) Adobe® 
Illustrator (.ai) and Wavefront® (.obj) format 
files. Import has no limits on file size other 
than system resources. Import implicitly 
always merges therefore you can add non-
native format models to your scene without 
loosing your current work. 
 
The 3DS Max® and Wavefront® import 
commands both have option boxes on the 
right of the menu item. The option boxes 
allow you to specify an Import Scale. This is 
useful since many models will be very small 
or absolutely huge when imported into 
Wings. By experimentation you can find the 
right scaling factor and then apply it each 
time you import models from another 
program. Simply apply the inverse scale upon 
export if you wish to take the model back to 
the originating program. 
 
The Nendo® import works much better than 
the others because it is a one-to-one 
translation. This is because both Nendo® 
and Wings use winged-edge data structures. 
Import of other formats is trickier. The other 
formats contains triangle or polygon meshes. 
To import them, Wings must combine the 
polygons into one or more closed objects 
that can be represented by the winged-edge 
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structure. Combining gets tricky if the mesh 
contains defects, and many meshes do since 
the defects usually are not a problem in 
other modelers or renderers.  
 
Also, if you import a model that has a texture 
associated with it you may get a Wings 
message box when attempting to modify it, 
telling you that the operation can not be 
performed on a textured model. This is 
because texture support in Wings is under 
development. In a future release of Wings, 
the question will be if you want to convert the 
texture to colors (just as in Nendo®). But 
currently, the workaround is to use the Strip 
Texture command in the Body pop-up menu. 
Or you can save the model as a Wings file 
and reload it. 
 
One thing new users may find helpful is the 
knowledge that Wings and Nendo® work well 
in tandem since Wings supports both the 
import and export of .ndo files. So you can 
model in Wings, take the model into Nendo® 
to do color assignments, and save the model 
with colors. Then you can use Wings File | 
Import (.ndo) and bring the model in with all 
the color assignments intact. Some Wings 
operations still cannot work with color 
assignments but you can smooth the model 
to a greater degree than is possible in 
Nendo® for a smoother looking model while 
still retaining the colors. 
 
Currently, Wings only import textures from 
the OBJ format, not 3DS. Acceptable file 
formats for textures are 24 bit BMP, TGA®, 
and TIFF. 

FILE | EXPORT 
 Nendo® (.ndo) 
 3D Studio (.3ds) 
 Hash Model (.mdl) 
 Wavefront (.obj) 
 VRML 2.0 (.wrl) 
 YafRay (.xml)) Optional 
 
Saves all objects in workspace in Nendo® 
(.ndo), 3D Studio (3ds), Animation Master 
(.mdl), Wavefront (.obj), or VRML 2.0 (.wrl) 
format. When YafRay rendering software is 
installed this option will appear. There are 
option boxes for .3ds, .and obj, exporters 

which bring up sub-menus for specifying 
parameters. The option box for .3ds allows 
you to enter an export scale. The option box 
for .obj allows this and a check box to create 
one group per material. YafRay uses the 
options setup under the File > Render > 
Yafray panel. 
 

Quick Tip: Rendering with YafRay 
On the PC side you can send a file to render 
in YafRay right from wings, but on the mac 
side you are limited to exporting the model 
and rendering from the command line. See 
section 7.1 YafRay. 

FILE | EXPORT SELECTED 
Saves selected elements in one of the export 
formats (see FILE | EXPORT). Note that the 
selection can be of any type (e.g. face 
selection). 

FILE | RENDER 
Renders the workspace using either the 
default OpenGL® render routine or YafRay if 
you have installed it correctly. Support for 
other rendering engines may be added in the 
future. The Option Button on the right will 
bring up a sub-menu for several parameters 
you can set. Before you can send the file to 
render in YafRay make sure you have added 
at least one light or you won’t see anything. 
The image is rendered from the point of view 
of the camera 

FILE | HISTORY 
If you have opened files previously you will see 
their filenames listed below File | Export. 
Clicking one will open that file (provided it is 
still in the same location where you had it at 
the time). The history list is currently limited 
to 4 files. 

FILE | EXIT (Ctrl-Q) 
Exits Wings3D. If changes have been made 
since your last save Wings will ask you if you 
want to save them before shutting down. 
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5.1.2 The Edit Menu 

Edit Menu – General 

The Edit Menu allows for operations which 
can directly affect your model such as Undo,  
Redo, Repeat, and Repeat Drag. It is also 
where the user can set up their operational 
preferences so that Wings looks and 
behaves they way they prefer it to work. 

EDIT | UNDO/REDO (Ctrl-Z) 
Reverses last action. The last Undo is 
redone, the last Redo is undone. 

EDIT | REDO (Ctrl-Shift-Z) 
Redo undone steps, up to 32 steps. 

EDIT | UNDO (Alt-Ctrl-Z) 
Undo up to the last 32 steps. 

EDIT | REPEAT (D) 
Repeats the last command. Note that the 
menu will read (Cant repeat "some 
command") D if the selection mode has been 
changed and the command doesn't exist in 
the current selection mode. Also, if the 
selection has been cleared, no command can 
be repeated. There are limits on what can be 
repeated. Interactive commands, commands 

where you drag, such as Extrude, will only be 
repeated up to when the dragging phase 
starts. You will have to do the dragging 
again, even if you want to drag exactly the 
same distance. 

EDIT | REPEAT DRAG (Shift-D) 
Repeat Drag repeats both the command and 
the interactive actions taken with the 
command. In other words, the mouse drag 
portion of an extrude, for example, is also 
repeated. So if your did an Extrude on a face 
for 3 units selecting the Repeat Drag option 
(Shift-D) would not only start the Extrude 
command, but would also do the extrude the 
same distance. 

 
Figure 35: The Edit Menu. 
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EDIT | MATERIAL 
        Default 
        Hole 
Brings up the Material Editor. This both 
shows the current material settings for the 
included colors and allows you to set their 
properties. You can set the color for the 
default object and hole colors and any 
materials you have created via the Face | Set 
Material command. Editable properties 
include: Diffuse, Ambient, Specular, 
Emission, Shininess, and Opacity. Diffuse, 
ambient, specular, and emissive colors are 
set via pop-up color mixers while 
shininess and opacity are set via sliders. 
The resultant overall material is shown 
on the ball to the left. Here is a screen 
shot of the Material Editor. 
 
Note that new materials are not created 
here. Use the FACE CONTEXT SENSITIVE 
MENU | SET MATERIAL | NEW to create 
a new material. Any new materials can 
then be edited via this EDIT | MATERIAL 
menu. 

EDIT |CAMERA MODE 
Wings provides users with the ability to 
set their own camera options so that you 
can 
work the way you like, rather than having 
to work in some predetermined manner. 
There are five camera options to choose 
from; Mirai®, Nendo®, Maya®, 3ds 
max®, and Blender. Additionally, there 
are options for setting up the scroll 
wheel for quick zooming with a user 
selected zoom factor. You can also set 
the field of view and the depth of the 
near and far clipping planes. 
 
 

 
This allows you to set Wings up to work the 
way you are used to working if you have used 
any of the other 3D modeling packages 
listed. Each camera mode is briefly outlined 
below. Note that lmb means left mouse 
button, mmb means middle mouse button, 
and rmb means right mouse button. To 
make the settings take effect, click the OK 
button. To return to Wings without making 
any changes click on the Cancel button. A 
brief summery of the camera mode 
operations follows. 
 
 

Figure 37: Camera modes. The Camera Mode sub 
menu has options to set the camera up to your liking. It 
also has settings to use the scroll wheel for zooming, the 
field of view, and the depth of the near and far clipping 
planes. 

 
Figure 36: The Material Editor. 
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Mirai® mode: 
mmb click and release = rotate mode 
mmb scroll wheel = zoom 
arrow keys = translate view 
rmb = return the original view, prior 
to tumbling. 
Q = toggle rotate/translate while in 
rotate mode. 
 

Nendo® mode: 
mmb click = rotate mode 
while in rotate mode, (mmb or rmb) 
drag to zoom 
lmb to exit rotate mode 
arrow keys = translate view 
In Nendo® mode you may use Ctrl-
rmb click to enter rotate mode if you 
don't have a middle mouse button. 

 

Maya® mode: 
alt + lmb = rotate view 
alt + mmb = translate view 
alt + lmb + mmb = zoom view 
 

3ds Max® mode: 
mmb = rotate view 
ctrl + mmb = translate view 
alt + ctrl + mmb = zoom view  
 

Blender mode:  
mmb = rotate view 
Shift + mmb = translate view 
Ctrl + mmb = zoom view 
If you don't have a middle mouse button, use Alt + 
lmb instead. 

 
Note that both the Max and Maya modes require a three-button mouse. 
 
Perhaps a quick word on clipping planes is in 
order here. The near and far clipping planes 
are simply the area in your workspace 
between which objects or parts of objects 
remain visible. So with a near clipping plane 
setting of 0.25 any portion of the object that 
is closer to the camera than 0.25 Wings 
units will vanish. With a setting of 1000 for 
the far clipping plane any portion of an object 
greater than 1000 units from the camera 
will likewise become invisible. The most 
practical implication here is if you want to 
zoom in very close for detail work you may 
find the area of interest suddenly disappears. 
To solve this either zoom out slightly or 
reduce the near clipping plane setting to 
something smaller, like 0.01 units. 
 

EDIT | PREFRENCES 
Wings allows the user to set numerous user 
interface preferences. This is accomplished 
via a preference dialog sheet which is 
accessed by selecting Preferences from the 
Edit Menu. When the dialog sheet comes up, 
set each preference as desired, then click 
OK to apply them and dismiss the sheet. If 
you change your mind or don't want to set 
any preferences click the Cancel button to 
dismiss the dialog sheet without applying 
them. Above is a picture of the dialog sheet 

as it is set in my working version of Wings. 
Note that by clicking on any of the color 
boxes a sub menu will pop up that allows you 
to set the colors interactively via RGB slider 
bars or by typing in individual vales for red, 
green, and blue. These settings are likewise 
set or abandoned via clicking on the OK or 
Cancel buttons respectively. 
Vertex Display – sets the size of the 
vertices on the screen in pixels. It is 
sometimes handy to increase vertex sizes to 
even as much as 12 – 16 pixels, for doing 
screen grabs, to help clarify a point on a 
discussion forum or in a tutorial. 
Edge Display – sets the size (thickness) of 
the edges on the screen in pixels. 
Colors – sets the Background, Text 
(workspace text), Selection, Edges, Hard 
Edges, and Wire Edges colors. By clicking on 
one of the boxes the color dialog box will 
come up allowing you to enter RGB values 
from 0-255. Enter each number then hit 
Return to accept the changes. You can drag 
and drop color patches from one box to 
another. 
Grid – the two options are Color, which 
works exactly as the Color options described 
above, and the Force Axis-Aligned Grid 
check box, which acts as a toggle. If turned 
on whenever you jump to a primary axis view 
(by hitting the X, Y, Z, Shift-X, Shift-Y, Shift-Z 
keys) the Grid will automatically turn on. 
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When you move out of such a view the grid 
will automatically turn back off. 
Highlighting – Vertex, Edge, Face, and 
Object highlighting are also On/Off toggles. If 
turned on then the item of that type will auto 
highlight when the mouse passes over them. 
This makes selecting the correct vertex, 
edge, etc. much easier as it gives a visual 
confirmation of just what is being pointed at. 
If the item the mouse is over is unselected it 
will highlight in the unselected color whereas 
if it is selected the item will highlight in the 
Selected color. These colors are set just like 
the Color options as described above. The 
Smart Highlighting check box allows Wings to 
automatically switch from the various 
selection modes (vertex, edge, and face) 
similar to how it works in Nendo®. This can 
speed up modeling quite a bit. 
Vector Display – Vector Display Length and 
Width set just that, the length and width of 
the line used to represent the active Vector 
in the advanced menus operations. Vector 
Display Color sets the color of the Vector 

used in the advanced menus operations. 
Colors are assigned just as described in the 
Color preferences section above. 
Auto Rotate – Auto Rotate Angel is 
entered as a real number in degrees of 
rotation. The Auto Rotate Delay is entered 
as an whole number, representing 
milliseconds between steps of rotation. The 
Auto Rotate function itself is accessed (and 
will be discussed) in the View menu 
structure. 
Axes – Show Axis Letters check box is an 
On/Off toggle. If turned on small X, Y, and Z 
letters will float at the + ends of the three 
axes, to help keep you oriented. The +X,Y,Z 
and -X, Y, Z Color boxes allows you to set 
the color for each axis which also helps keep 
you oriented while modeling. These are set 
by the color preferences boxes for each, just 
like in the Color options described above. 

Figure 38: The Preferences Menu. 
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Miscellaneous – There are several 
miscellaneous preferences as described 
below. 
 Auto-save interval (min) saves to 
a temporary file with the extension 
.wings_as. It will NOT overwrite the 
current file. If there is a crash, the next 
time you try to open the file (with .wings 
extension), you will get a prompt asking 
you if you want to load the auto-saved file 
instead. (It compares the date/time of the 
files.) Auto-save won't start before you 
have done a save-as once. If you turn off 
auto-save (0) and then turn it on again, 
the auto-start mechanism won't start until 
the next time you start wings. It's not used 
for imported files. Enabling Auto-save also 
enables the auto backup function of Wings. A 
backup file will be saved each time you save 
your work, i.e. your previous file 
will be stored as FILENAME.wings_bup. If you 
want to load a backup file use Open and look 
for *.wings_bup files. 
 Advanced Menus enables Wings 
advanced menus operations. If advanced 
menus are turned on then you can use some 
of the advanced manipulation tools designed 
by Chris Osgood which have been 
incorporated into Wings. Many of these 
functions operate on the premise of selecting 
and using a secondary vector as a reference 
about which the advanced functions work. 
These vectors are visible (if advanced menus 
are on) and their appearance characteristics 
of width and color are user definable via the 
Vector Display Width and the Vector Display 
Color options here. 
 Show Debugging Info works as a 
toggle. If activated, the amount of memory 
currently being used by Wings, the number 
of items in the display list and the number of 
binaries in use are displayed dynamically in 
the lower left of the workspace. 
 
Another point, Wings keeps your custom 
preferences even when you upgrade to a new 
version. 

EDIT | COMPATIBILITY 
The Compatibility menu allows the user to 
toggle on/off several options in Wings. 
These are; Optimize display lists, Use display 
lists for text, Show dummy axis letter, and 
Early back buffer clear. In general, you 
shouldn't change these options from their 
default  
values unless you have some sort of problem 
using Wings. 
 
One-button mouse: The default is on. To 
use the default Wings/Blender camera 
mode on a Mac with a one-button mouse you 
must first enable this option. To emulate the 
middle mouse button hold down the 
[Alt/Option] key. To emulate the right mouse 
button hold down the [Command] key. This 
option has no effect on Windows or Linux® 
based systems. 
 
Optimize display lists: This is a toggle that 
tells Wings to optimize how it handles the 
internal list of drawing elements for screen 
refreshment. It is generally recommended 
that this option be set to On. However, some 
combinations of drivers/graphics card 
seems to handle it incorrectly, causing 
Wings to crash with a General Protection 
Fault or similar.  So if you have display 
problems or crashes, try turning this off to 
see if that solves the problem. The default 
setting is on, which is the fastest setting.  
 
Use display lists for text: The default is on. 
If text doesn't show up in menus and other 
places, try turning off this option. (Known to 
be an issue on some Matrox cards.)  
 

Figure 39: Compatibility. Use the Edit|Compatibility 
Menu to fix display and operational problems if you 
have difficulties running Wings on your system. 



Section 5.1 The Menus  WINGS3D USER MANUAL 

54 DRAFT 1.6  

Show dummy axis letter: The default is off. 
If Wings crashes when trying to open menus 
when the axes and/or axis letters are turned 
off, try turning on this option. (Known to be 
an issue on some Matrox cards.)  
 
Early back buffer clear: The default is off 
on Mac OS X and default on on all other 
platforms. There is probably no reason to 
change this option. 
 
There are two screen buffers, a front buffer 
and a back buffer. The front buffer is what 
you currently see on screen. The back buffer 
is used for drawing what you will see next. 
When everything is drawn, the buffers are 
swapped.  
 
On all platforms but Mac OS X, Wings clears 
the back buffer immediately after swapping  
(because that is somewhat faster). That is 
what Björn calls "early clear". On Mac OS X, 
it seems that the back buffer can be used by 
the OS, which resulted in a blank Wings 
window. When the option is turned off, 
Wings does a "late clear", i.e. it will clear the 
back buffer immediately before starting to 
draw in it. 
 

EDIT | PURGE UNDO HISTORY 
This will purge the undo history, as stated. If 
you purge the history, you will not be able to 

UNDO changes to your model. The function 
is intended to reclaim memory. It is especially 
useful in one situation; when smoothing large 
models. If you find that you are running out of 
memory, purge the undo history after each 
smoothing. 
 

Quick Tip: Repeat and the Function 
Keys 
You can do some quick and easy 
modifications to a model through the 
combination of the Repeat (D) and Repeat 
Drag (Shift+D) operations and the F3/F4 
(Next Loop/Previous Loop) keys. The Repeat 
and Repeat Drag operations can be 
performed over and over again on successive 
loops as you F3 and F4 your way up and 
down a portion of your model. A simple 
example would be, if you wanted to make a 
segmented body, such as a worm. You could 
start with a many segmented cylinder, then 
choose the first loop that you wanted to 
adjust and do a Scale | Uniform. Then you 
would hit F3 twice to move up two loops and 
reapply the Scale | Uniform by simply hitting 
Shift+D. Or to make the worm tapered, hit D 
and use the mouse to adjust the amount of 
scaling. Keep repeating the process until you 
have the entire cylinder done.  
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5.1.3 The View Menu 

VIEW MENU – GENERAL 

The View Menu contains functions that set 
and control how you view your work; i.e.  
camera and work environment settings. 

VIEW | GROUND PLANE 
Toggles the ground plane visibility on/off. 
Each grid cell of the ground plane represents 
one "unit" in Wings. A unit can be whatever 
you want it to be. 

VIEW | AXES 
Toggles axes visibility on/off. 

VIEW | WORKMODE (Tab) 
Toggles the display between work mode and 
smoothed mode.  

VIEW | SMOOTH PREVIEW (Shift-
Tab) 
Sets the view mode to shaded and performs 
one level of smoothing on a temporary basis 
so that you can see what your model will look 
like after smoothing. You cannot model in 
this mode.  

VIEW | WIREFRAME 
Sets the display mode to wireframe. If you 
want to extrude a face into the model, set 
your model to wireframe mode first and you 
will be able to see how far into the model you 
are going. 

VIEW | SHADE 
Sets the display mode to solid flat shading. 
Toggles between smooth shaded view and 
solid view on your model. In smooth shaded 
view the materials being used become visible. 
This is sometimes referred to as a Wings 
render. 

VIEW | TOGGLE 
WIREFRAMED/SHADED (W) 
Toggles between wireframe and shaded 
views of the model. This is a handy toggle to 
use in conjunction with the Tab key. Tab will 
show you a temporarily smooth-shaded 
version of your model which you can then 
overlay with the wireframe by hitting the W 
key. This wire on smoothed view can be 
helpful to see how edges affect the overall 
form of the subject while modeling. 

Figure 40: The View Menu. 
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VIEW | SHOW SAVED BB 
Shows/hides the bounding box set in the 
Tools Menu. If set on, a dashed wireframe 
outline shows the extent of the box.  Wings 
can save a  single vertex or single edge as a 
bounding box. Bounding Boxes can be very 
useful for proportionally scaling and moving a 
large imported object to a desired volume 
and position, and can also be used as 
reference points with vector, magnet, and 
“snap-to” operations.  

VIEW | SHOW EDGES 
In flat shaded mode, toggles the edges 
on/off. This can be useful for very large 
models, as some otherwise fast graphics 
cards display edges slowly. 

VIEW | SHOW NORMALS 
A toggle that shows/hides the normals of 
every face, edge or vertex (depending on 
which selection mode you are in) of the 
model, as a short thick blue line. Handy for 
planning how things will be moved, as a visual 
aid if rotating faces around an edge, and to 
see the normals on an imported model which 
may have some or all of the normals 
inverted. 
 

VIEW | SHOW WIREFRAME 
BACKFACES 
Lets you see the wireframe from both front 
and back in wireframe mode. This can be 
very useful when trying to position edges to 
match up on the inside and outside of a wall, 
for example, prior to using Bridge to cut in a 
window. 

VIEW | RESET VIEW (R) 
Resets the camera to default location and 
zoom. Great if you get lost. 

VIEW | AIM (A) 
Points camera directly at selected objects, 
faces, edges or vertices. Then when you pan 
and zoom in on the selected the item, it will 
stay centered in the work space. If there is 
no selection, the aim point will be reset to 
the origin (0, 0, 0). This is very handy when 
doing detailed work and for doing high aspect 

ratio stuff, such as a giraffe. When working 
on the head, select a face on the head and 
Aim. Then all camera movement will be 
centered on the head. Then when working on 
the feet select a face there and Aim there, 
and the point of focus will be on the foot. 

VIEW | FRAME (Shift+A) 
View | Frame works similarly to Aim except 
that it adjusts the distance to the selection 
so 
that the selection will be visible in the Wings 
window. If there is no selection, the distance 
will be chosen so that all objects will be 
visible. 

VIEW | ORTHOGRAPHIC VIEW (O) 
Toggles orthographic/perspective views 
on/off. Orthographic views are the same as 
those traditionally used for engineering or 
technical drawing purposes – i.e. front, side 
and plan views. Since there is essentially no 
single point of view (as in perspective) all 
lines and faces are seen in their true lengths 
and shapes - provided they lie on a plane that 
is at right angles to the viewing direction. 
This can offer an advantage when moving or 
editing geometry that, for example 'bulges 
out' towards the viewer. The use of 
Orthographic View is well married with the 
use of Move | Free, allowing you to freely 
move selected items while automatically 
constraining such movement to only two 
directions at a time. 

VIEW | SCENE LIGHTS 
Turns on any lights you may have added to 
the scene via the Lights primitive. 

VIEW | ONE/TWO LIGHTS 
Toggles one or two standard lights on in the 
scene. To avoid confusion consider this menu 
item as a request. That is, if the menu reads 
One Light, then two lights are currently on, 
and vice versa. Note that Scene lights negate 
the One Light/Two Light option. 

VIEW | SHOW COLORS 
Vertex colors can be imported on pre-existing 
models (such as from Nendo®). To see the 
vertex colors use this option. 
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VIEW | SHOW MATERIALS 
Materials can be created and assigned in 
Wings per face with the Face | Set Material 
command. They can also be present on 
models you have imported. To show 
materials use this option. 

VIEW | SHOW TEXTURES 
Models with pre-existing textures can be 
imported into Wings. The textures are 
retained after import and can be seen via 
this option. 

VIEW | VIEW ALONG (X, Y, Z, 
Shift-X, Shift-Y, Shift-Z) 
        +X X 
        +Y Y 
        +Z Z 
        -X Shift+X 
        -Y Shift+Y 
        -Z Shift+Z 
Sets the camera to view along the selected 
axis. It is recommended that you look at your 
model from various angles as you go, to get 
a good feel for how it is developing. Using the 
X, Y, Z (etc.) hot keys is a very quick and 
easy way to do this. It is also very handy to 
view along a major axis while scaling, as you 
can scale two vertices along a cross axis to 
spread them apart or move them towards 
each other. Useful in conjunction with 
orthographic mode for certain tasks where 
precise movement / alignment is required. 

VIEW | ALIGN TO SELECTION 
Turns the camera to point in same direction 
as selected elements. Wings then orientates 
the model such that you are viewing along 
the selected element's normal. This can be 
very useful if a single (flat) face is selected 
and Align to Selection is used. The face is 
then seen in its true shape, since the viewer 
is looking at it from a right angle. Selecting 
geometry forming that face (edges or 
vertices) and using Move -> Free (for 
example) allows movement on the same 
plane as the face. This keeps the face flat, 
which is required for clean geometry. 
 
This is also useful in situations where you 
want to maintain a reference face, so that 
other geometry not linked to that reference 

face can easily be moved on planes parallel 
to the reference face. To accomplish further 
editing of this 'external' geometry, select the 
reference face, use Align To Selection, and 
the model re-aligns to the correct position. 
For example, Align To Selection can be used 
on a flat face, then an edge can be Cut by 2 
to create a new vertex. It is then possible to 
'slide' the new vertex along the edge to a new 
position. The edge can either be kept straight 
via vector moves (discussed later) or 
'distorted' by moving the vertex accordingly to 
form a new apex. In either case, by first 
using Align To Selection, the face will remain 
flat. Similar operations can be preformed via 
other methods as well, such as the Slide 
plug-in which will be discussed later. 

VIEW | AUTO ROTATE (U) 
This will fly your camera around the model, 
so that it appears to rotate. The angle and 
speed of rotation can be set via the Edit | 
Preferences menu. Rotating gives you a good 
overall view of the model, and can be used in 
conjunction with screen capture software to 
create an AVI to show off your model. Left 
click to stop the rotation. You can change 
the aspect of the camera with the middle 
mouse button during rotation and the 
rotation will continue. 

Quick Tip: View Orthographic in 
Wireframe Mode. 
Sometimes it is not all that obvious what the 
difference between Orthographic and 
Perspective views do for you. To see this 
graphically, create a cube and hit the X key 
to look at it straight on. Then hit the O key a 
couple of times. It does not seem to do much 
other than change sizes, right? Now hit the 
W key to put the cube into Wireframe Mode 
and repeat the exercise.  You can definitely 
see the effects of perspective now, even 
when looking dead on.  Now use the 
marquee select function (drag a box) to 
select the top left vertex of the cube while 
still in  perspective view. You get one vertex 
selected. Clear the selection and go into 
Orthographic View. Select the top left vertex 
via marquee drag. Rotate the camera a little 
and you will see that you got both the front 
and back vertices because you were in 
Orthographic view. This can be very useful 
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when you are working on a complex but 
symmetrical, or nearly symmetrical model. 
To get the vertices of the left and right 

thumb, as an example, you can go into 
Orthographic view and use a marquee select 
to get both sets at once. 

 

 

 

Image by Mentat7 (www.sargentgfx.com) Rendered in Cinema4D 
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5.1.4 The Select Menu 

SELECT MENU – 
GENERAL 

The Select Menu is one of the most 
important items in Wings3D as it contains 
many 
operations that lead to fast and efficient 
modeling. By being able to quickly select the 
elements you need to work with, and even 
combine (or subtract) that selection with 
another selection set you can quickly achieve 
the results you desire.  

SELECT | DESELECT (Space) 
Deselect all selected items. 

SELECT | MORE (+) 
Grows the selection set to include all the 
adjacent items (vertices, edges, or faces) of 

the same type on a given object. For 
example, if a face is selected all adjacent 
faces will become selected as well. If there 
are multiple objects in a scene, it will not 
cause more objects to be selected, however, 
each object with a selection set active will 
have it's selection set grow.  

SELECT | LESS (-) 
Shrinks the selection set in reverse order of 
it's growth. If working with an initial selection 
set, this will cause nothing to be selected. As 
with More, selection sets on multiple objects 
can be manipulated at the same time. 

SELECT | REGION (Shift-L) 
Select | Region works in conjunction with a 
properly selected closed edge loop. Given a 
properly selected edge loop, Select | Region 
will then select all the faces contained by that 
loop. If a single edge is selected, or if the 
loop is not closed, then all the faces become 
selected. Select|Region will also handle 
multiple loops. For instance, you can select 
both hands or both legs. Select|Region and 
Select|Edge Loop are the inverse of each 
other. 

SELECT | EDGE LOOP (L) 
Selects edges that flow in a line until a pole is 
encountered. A pole is a non-4way 
intersection (i.e. it has 3 edges or 5 or more 
edges joining at a single vertex). 

SELECT | EDGE RING (G) 
Selects a set of edges that run between two 
edge loops. These cross edges are 
sometimes referred to as "struts". If you 
think of the lines of latitude on a globe as 
edge loops, then the lines of longitude 
between any two parallels would constitute 
an Edge Ring. In Wings, simply select one 
such "strut" then Select | Edge Ring, and the 
entire set of edges will become selected, 
until the model is completely encircled, or 
until a pole is encountered. This can result in 
big time savings when modeling. 

Figure 41: The Select Menu. 
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SELECT | PREVIOUS EDGE LOOP 
(F3) 
This will "step" down the model from one 
closed edge loop to the next, deselecting the 
originally selected loop in favor of the next 
one it encounters. Repeated use of F3 
continues on down the model until it no 
longer finds another loop to select, then it 
reverses order and comes back up the 
model. This is very powerful and when used 
in conjunction with other functions (such as 
Scale, Move, Rotate, etc.) and can greatly 
increase the efficiency of your modeling work 
flow. 

SELECT | NEXT EDGE LOOP (F4) 
This will "step" up the model from one closed 
edge loop to the next, deselecting the 
originally selected loop in favor of the next 
one it encounters. Works just like F3, except 
it goes in the opposite direction, so that you 
can use the two function keys to toggle back 
and forth between two edge loops, or change 
directions at will. 

SELECT | SIMILAR (I) 
Selects items similar to the currently 
selected item. Select | Similar is not that 
useful for organic modeling. Its main 
strength is in what Jakob Cederlund calls 
geometric art (i.e. objects that are highly 
symmetrical). It is good for selecting faces 
widely apart. The rules for similarity are as 
follows. 
 
Faces - Same number of edges. Sum of edge 
lengths approximately equal. Sum of angles 
between each pair of edges approximately 
equal. 
 
Edges - Approximate length of edge equal. 
Angle and length of the nearest four edges 
approximately equal.  
 
Vertices - Angle and length of edges going 
out from the vertex approximately equal. This 
may be the least useful of the bunch, as it 
seldom finds many hits. 
 
Note that Less does not deselect items 
selected via Similar; i.e. it does not revert to 
the original selection set. 

SELECT | ADJACENT 
 VERTICES – selects vertices adjacent 
to the currently selected vertex/vertices. 
 EDGES – selects edges adjacent to 
the currently selected edge(s). 
 FACES – selects faces adjacent to the 
currently selected face(s). 
If you press the same key several times, the 
selection will grow each time. In vertex 
selection mode, pressing the "v" will grow the 
selection in exactly the same way as does 
SELECT | MORE. However, in edge selection 
mode, pressing "e" will grow the selection by 
selecting the four edges nearest each edge. 
SELECT | MORE, on the other hand, will 
select all edges that share a vertex with a 
selected edge. To see the difference, select 
one edge on an icosahedron or a grid and try 
both commands. In face selection mode, all 
faces that share an edge with a selected 
face will become selected. SELECT | MORE, 
on the other hand, will select all faces that 
share a vertex with a selected face. Try it out 
on a grid to understand the difference. 
 
Note that if there is no current selection set 
the keys v, e, f (and b) simply change 
selection mode to vertex, edge, face and 
body, respectively. 

Model by Mr. Christopher. Rendered in 
Strata Studio 
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SELECT | BY 
 Hard Edges 
 Vertices with 
  2 Edges 
  3 Edges 
  4 Edges 
  5 Edges 
 Faces With 
  2 Edges 
  3 Edges 
  4 Edges 
  5 Or More (F5) 
 Material 
  Default 
  Hole 
 Random 
  10% 
  20% 
  ... 
  90% 
 Short Edges [] Click on the box to the 
right to specify how short. 
 Id 
 
Select | By offers a wide variety of 
methodology to choose selection sets. These 
selections can be stored (as discussed later) 
and then used in conjunction with other 
selection sets via Union, Subtract, and 
Intersection (also discussed later).  
 
Hard Edges selects all Hard Edges in the 
selected object. 
 
Vertices with (2, 3, 4, and 5) selects faces 
that have the given number of vertices as 
designated by the number. This is helpful in 
trying to maintain quads. 
  
Select | By | Faces With | 5 Or More has a 
hot key, F5, so that you can quickly find any 
non quad or tri sided polygons. Such 
polygons can cause problems in some 3D 
modeling and rendering packages and should 
therefore be resolved. 
 
Material is used to select faces by their 
assigned materials. Any user-defined material 
will automatically be added to the Material 
sub-menu and become available for selection. 
 

Random (10 – 90%) selects a random 
subset of the current selection type (vertices, 
edges, faces or objects) for manipulation. 
 
Short Edges selects any edges that are too 
short, as determined by the option box to the 
right of the command. Short edges are often 
responsible for display anomalies and 
difficulties in continued modeling. Often these 
edges will be so short and located such that 
you can not see them, even after selecting 
them. You can Extrude them to find them, or 
simply Collapse them to eliminate them.  
 
Id. You can also select any item (vertex, 
edge, or face) by its ID number, which can 
be gleaned from the Wings status bar when 
the item is selected. So, if you record an ID 
number you know you want to come back to, 
you can later Select it then Aim at it to 
continue working in that area. 
 

SELECT | LIGHTS 
Will select all the lights in your scene. 

SELECT | ALL [Vertices, Edges, 
Faces, Objects] (Ctrl+A) 
Selects all the vertices, edges, faces, or 
objects, dependent on the current selection 
mode. For objects, it selects all within the 
scene that have not been hidden or locked 
(via Object |  [object name] | Hide or Lock (to 
be discussed later)). 

SELECT | INVERSE (Ctrl-Shift-I) 
Inverts the selected set. That which was 
selected becomes unselected and vice versa. 

SELECT | STORE SELECTION 
Stores a selection set so that it can be used 
in conjunction with other selection sets. 

SELECT | RECALL SELECTION 
Recalls a selection set so that it can be used 
in conjunction with other selection sets. 
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SELECT | EXCHANGE SELECTION 
Exchanges a selection set so that it can be 
used in conjunction with other selection sets. 
The current selection set becomes the 
stored selection set while the stored 
selection set becomes the active one. 

SELECT | UNION WITH STORED 
Creates a new selection set by combining the 
current selection set with one that has been 
stored. 

SELECT | SUBTRACT WITH 
STORED 
Creates a new selection set by subtracting 
the stored selection set from the current 
selection set. That is, all items in common 

between the two sets are deselected from 
the current selection set. 

SELECT | INTERSECTION WITH 
STORED 
Creates a new selection set intersecting the 
current and stored selection sets. That is, 
only those items that are common to both 
sets remain selected. This can be used very 
effectively to add noise to an organic model. 
You can store all the vertices on a tree 
trunk, for example, then Select | By | 
Random | 30% which will select vertices on 
trunk, branches and leaves. Then do a 
Intersection With Stored and only random 
vertices on the trunk will remain selected 
which you can then Move | Normal to make 
knobs. 

Model by Mr. Christopher. 
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5.1.5 The Tools Menu 

Tools Menu – General 

The tools menu contains some functions that 
will interact with other Wings commands. 

TOOLS | ALIGN 
 All 
 X 
 Y 
 Z 
 Radial X (YZ) 
 Radial Y (XZ) 
 Radial Z (XY) 
 
Aligns all selected objects based on the 
bounding box of the selection for each 
element. This can be useful to line things up 
once they have gotten off center. For 
example by using a series of Aligns, you 
could get wheels on a model that have 
become misaligned back into proper 
positions relative to each other. It does not 
align vertices, edges or faces to an axis on 
the same model. 

TOOLS | CENTER 
 All 
 X 
 Y 
 Z 
 Radial X (YZ) 
 Radial Y (XZ) 
 Radial Z (XY) 
 
Centers objects in the workspace based on 
the bounding box of all selected items. If you 
work on a large model that has sort of 
"grown" off in one direction, you can quickly 
center it in the workspace again. Also, if you 
have multiple objects in a complex model, 
and you've lost track of one of them, you can 
select it (via the Objects Menu – to be 
discussed latter) and then Center to find it 
again. 

TOOLS | SAVE BOUNDING BOX 
Saves the bonding box of selected items, 
from one or more objects, for later use. Use 
Save Bounding Box without any selection to 
clear the bounding box. An outline of the 
current bounding box is displayed if so 
chosen in the users' preferences. 

TOOLS | SCALE TO SAVED BB 
 All 
 X 
 Y 
 Z 
 Radial X (YZ) 
 Radial Y (XZ)  
 Radial Z (XY) 
Scales the selected object(s) to the bounding 
box that has been previously saved. This 
command will scale each selected object, 
along one, two, or three axes. The amount to 
scale could be different along each axis, 
meaning that this command can distort the 
proportions of the objects (i.e. a cube might 
no longer remain a cube). The scale factor 
for each axis is computed by comparing the 
saved bounding box with the bounding box for 

Figure 42: The Tools Menu. 
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the selection. To avoid distorting the objects, 
use Scale to Saved BB Proportionally. 
 

TOOLS | SAVE TO SAVED BB 
PROPORTIONALLY 
 All 
 X 
 Y 
 Z 
 Radial X (YZ) 
 Radial Y (XZ)  
 Radial Z (XY) 
Similar to Scale to Saved Bounding Box, but 
the idea with this one is that it should 
preserve the proportions of the selected 
objects, i.e. all axes will be scaled the same 
amount. This command will keep the scaled 
objects inside the saved bounding box. 
 

TOOLS | MOVE TO SAVED BB 
 All 
 X 
 Y 
 Z 
Will move the selected object(s) based on 
the center of their aggregate bounding box to 
the center of the saved bounding box. 
 

TOOLS | SET DEFAULT AXIS 
Sets the default axis for vertex commands. 
 

TOOLS | VIRTUAL MIRROR 
The Virtual Mirror tool puts you into a special 
modeling mode for creating perfectly 
symmetrical models. To use it select a face 
to mirror around and then select Virtual 
Mirror. The model will be mirrored from the 
selected face so that as you make changes 
on either side of the model they will be 
reflected on the other side of the model. This 
has the potential for cutting your modeling 
time in half and can be used to do some 
things that are otherwise sometimes difficult 
to achieve, such as rotating two surfaces in 
opposite directions. Note that if you want 
your model to stay centered in the 
workspace it is best to loop cut the model 
down the middle, delete half the model, 

select the resulting face, and then start 
Virtual Mirror. 
 Create – Creates the virtual half of 
the model which mirrors the real half. Note 
that you can work with either the virtual or 
real half and actions will be reflected on the 
counterpart. 
 Break – Destroys the virtual mirror so 
that only the real half of the model remains. 
 Freeze – Makes the virtual half of the 
model into real geometry, thus creating a 
perfectly symmetrical full model. 
 

TOOLS | TWEAK 
Tweak is a special modeling mode that allows 
you to drag vertices freely for fine 
movements. It is a very useful and powerful 
tool that warrants getting used to. Most of 
the controls are clearly explained on the 
status bar at the bottom of the workspace, 
as outlined here:  
 (L) – Left mouse button; Drag 
vertices freely 
 (R) – Right mouse button; Exit tweak 
mode 
 (M) – Middle mouse button; Tumble 
 (Shift-M) – Shift plus the middle 
mouse button; Track 
 (Ctrl-Shift-M) – Control plus Shift 
plus the Middle mouse button; Dolly 
 (1) – Turns the magnets on or off. 
 
You can use Tweak with standard moves, or 
with magnetic moves. To turn on the 
magnets press the 1 (the number 1) key. 
Doing so will cause the status bar to change. 
While in magnet mode L will drag and R will 
exit Tweak mode. The + key will increase the 
fall-off zone while the – (minus) key will 
decrease the fall-off zone. The 2, 3, and 4 
keys will change the type of magnet in use. 
Pressing the 1 key will turn the magnets off 
again. 
 
These controls effectively turn Tweak into an 
interactive magnet with the area of influence 
for the magnet defined by the fall-off zone. 
Tweak was originally a plug-in designed by 
Howard Trickey and has since been 
incorporated into the Wings3D core. 
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Quick Tip: Additional Tools 
Note that some very useful tools for Wings 
will appear in the Tools Menu if you have 
installed the available plug-ins. These include 
Draw Loop, Locked, Slide, and Tweak_s from 
Clacos. They are available at: 
 http://members.lycos.co.uk/clacos/ 
I highly recommend them. Apologies to any 
other tool makers if I'm missing any.  
 

Quick Tip: Bounding Boxes 
Don't overlook the usefulness of bounding 
boxes. You can use them to place an object 
at any given location, such as putting a hat 
on a hat rack. To do so select a vertex on 
the hook of the hat rack and do a Save 
Bounding Box. Then select a vertex on the 
inside of the hat and do a Move To Saved 
BB. The hat will snap right into place. 

 

Image by Mentat7 (www.sargentgfx.com) Rendered in Cinema4D 
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5.1.6 The Objects Menu 

Objects Menu – General 

The Objects Menu presents you with options 
limited specifically to whole objects. 

OBJECTS | SHOW AND UNLOCK 
ALL  
Pretty self explanatory. It shows all objects in 
the workspace, and if any of them were 
locked, unlocks them, making all objects 
eligible for further manipulation. 

OBJECTS | HIDE SELECTED 
Hides any object or multiple objects that are 
currently selected. This is handy to hide a 
large, easily selected object, so as to be able 
to get to and manipulated a smaller object 
that his mostly or completely obscured by the 
larger object. Once hidden, the objects are 
locked and therefore protected from any 
changes. 

OBJECTS | HIDE UNSELECTED 
Hides any object that is not currently 
selected. Hidden objects are automatically 
locked and protected from any 
geometry/orientation changes. 

OBJECTS | LOCK UNSELECTED 
Locks unselected objects, but leaves them 
visible in the workspace as reference objects. 

OBJECTS | {OBJECT LIST} (object1 
would be cube1 for the example 
shown above.) 
[] object1 
 Select 
 Hide 
 Hide Others 
 Lock 
 Rename 
[] object2 
 Select 
 Hide 
 Hide Others 
 Lock 
 Rename 
[] object3 
 Select 
 Hide 
 Hide Others 
 Lock 
 Rename 
and so on... 
 
The bottom part of the Objects Menu shows 
a list of all the current objects in the 
workspace. They will initially have default 
names based on how they were created. For 
example, when a cube primitive is added to 
the workspace when Wings is first started, it 
will be named cube1. Note that if you do a 
File | New, the item numbers are not 
reinitialized. So if you then added a cube to 
the new workspace it would be listed as 
cube2. The open eye icon to the left of the 
name (represented in this document as [] 
brackets) will show if it is currently visible and 
change to a closed eye icon if it is hidden. 
Each object in the list has a sidebar menu 
from which you can do many handy things. 
From this menu an object can be 
Selected/Deselected,  Hidden/Shown (note, 
if hidden Show is the only option in the side 
bar menu), Locked/Unlocked, and Renamed. 

Figure 43: The Object Menu. 
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Objects retain the name assigned to them 
upon Save and Export, which is very useful in 
texture mapping applications later on. Hide 
Others (the middle option in the menu) does 
not work on the selected object. Rather, it 
hides all the rest of them. This is very useful 
when working in a multi object scene. As 
mentioned elsewhere, the Object Menu can 
be used to find objects you've lost track of, or 

to recenter around a specific object. To do 
this simply choose Object | Select and then 
use Tools | Center | All to find/recenter on 
the elusive object. Currently this is a single 
column, non-scrollable list, so if your scene 
has a lot of objects in it, they may not all be 
accessible via this menu. 
 
 

Model by Mike Gleason. Rendered in Strata Studio 
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5.1.7 The Help Menu 

Help Menu – General 

The Help Menu contains some general 
information on selected topics. They are 
pretty self explanatory, and new users would 
be advised to read through them. They are 
brief, so it won't take very long.  

HELP | GETTING STARTED 
Basics on program navigation. 

HELP | USING A MOUSE WITH 
ONE OR TWO BUTTONS 
Explains how to tell Wings what type of 
mouse you are using. 

HELP | FRENCH AND GERMAN 
KEYBOARDS 
Explains how keyboard mapping differ for 
French and German keyboards. 

HELP | LIGHT BASICS 
Tells you how to create, manipulate, and use 
lights in Wings. 

HELP | ASSIGNING HOTKEYS 
Explains how to assign and delete hot keys in 
Wings3D. Figure 44. The Help Menu. 

HELP | ADVANCED MENUS 
Tells you how to turn on the advanced menus 
and why you would want to. 

HELP | OPENGL INFO 
Tells you some basic information about your 
graphics card and how it handles some of 
the OpenGL® properties. Could be useful 
information to include if you report a bug that 
deals with how Wings displays things on your 
system. 

HELP | ABOUT 
Displays the current revision number for 
Wings3D. 

 
 

Figure 44. The Help Menu. 
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5.2 The Context Sensitive Menus 
The key to the Wings3D user interface is the 
use of context sensitive pop-up menus. These 
menus are accessed by right clicking in the 
workspace. There are a total of five context 
sensitive menus; the Primitives Menu, the 
Vertex Menu, the Edge Menu, the Face 
Menu and the Object Menu, not to be 
confused with the Objects Menu on the Main 

Menu). Depending on what is selected, 
different menus will pop up presenting the 
user with operations that are applicable to 
the current situation only. In this way the 
interface is kept clean and simple, a joy to 
work with compared to many overly complex 
user interfaces found in some graphics and 
modeling packages. 

 

5.2.1 The Primitives Menu 

Primitives Menu – General 

To bring up the 
Primitives Menu, 
right click on the 

empty 
workspace, or 
on a 

workspace 
where nothing is 
selected. You 
will be presented 
with a list of 

available 
primitives to add 
to your 
workspace. Left 
click on one of 
the primitives to 
add it. It will be 
added to the 
center of the 
scene as an 

unselected 
object at it's 

default size. 
You may need 
to turn other 

objects' 
visibility off (via 

the Objects Menu) in order to find the newly 
added object. The complete list of standard 
primitives is given below. Notice that some 
primitives have a little box icon to the right of 
their name. This is the Options Box for that 

primitive. If you click on the primitive name 
you will add a default primitive, whereas, if 
you click on the options icon you will be 
presented with some options (number of 
sections, number of slices, etc.) that you can 
change. 
 
Tetrahedron – a four sided object; a 
triangular pyramid. 
Octrahedron – an eight sided object. 
Octotoad – A twenty-six sided object, unique 
to Wings. Designed by Mike (roadtoad), the 
host of the Wings discussion forum, and 
added to the Wings primitives as a tribute to 
the great service this board provided in the 
further development of Wings3D. 
Dodecahedron – a solid object with twelve 
faces. 
Icosahedron – a solid object with twenty 
faces. 
Cube – Plain and simple. What most models 
start out as. 
Cylinder  – Click on the options button (the 
little box on the right) for the Sections option. 
A Windows dialog box will come up showing 
the number of sections in the cylinder (16 by 
default). You may change this and then click 
OK, or click Cancel. If you do not click on the 
options button, but simply click on the name 
Cylinder, then a default cylinder will be added 
(with 16 sides). 
Cone – Sections (16 by default). 
Sphere – Sections (16 by default) and  Slices 
(8 by default). 
Torus – Sections (16 by default) and  Slices 
(8 by default). 

Figure 45: The 
Primitives pop-up 
menu. 
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Grid – Rows/Cols (10 by default). There is 
only one variable, so you must have the same 
number of rows and columns in your grid. 
After it is added you can change this by 
Dissolving some of the edges or by 
Connecting some of the edges to suite your 
needs. The default thickness of the grid is 
0.2 units. 
Light – Adds a light to the scene. Wings 
supports four types of lights; Infinite, Point, 
Spot, and Ambient. Infinite lights act much 
as the sun, so that the light rays are 
essentially parallel as they pass equally 
throughout the workspace in the same 
direction. A point light is like a light bulb, 
radiating light equally in all directions from it's 
source. A spotlight casts light in a cone 
shape, in a general direction but spreading 
out so that the rays are not  parallel. Finally, 
ambient light is the general background light 
present everywhere. It has no locational 
source nor direction. Since ambient light is 
everywhere from all directions it can cause 
your model to look completely flat if used by 
itself. So always use ambient lights in 
conjunction with other light sources.4 Lights 
in Wings are further explained in the Help 
Menu under Light Basics. Light parameters 
are adjusted by selecting a light and then 
right clicking to bring up the Light Operations 
Menu. 
Image – The Image Primitive is simply a 
plane that has an image pasted on it. The 
image can be a BMP, TIFF, or Targa file all of 
which must be 24 bits deep. Simply select 
Image, then select the type of image from 
the sub-menu, then navigate to the image file 
you want to use. Be aware that Wings works 
with images sized by powers of 2 
(1024x1024 or 64x128 for example). This 
does not mean that Wings will not load your 
image if it is not so sized, but it will pad it to 
be powers of two prior to displaying it. This 
should be transparent to the user. Once you 
load the image a plane will appear centered 
on the screen standing up vertical on the Z 
axis. You can use this as a reference plane 
to assist you in your modeling. You can use 
two Image primitives to perform a modeling 
technique know as Rotoscoping, where one 

                                           
4Principles of Three-Dimensional Computer Animation, 

Revised Edition; Michael O'Rourke; W.W. Norton & 
Company, © 1998; pp. 89-92. 

image is from the front and the other from 
the side of a given subject. You can then 
arrange the image planes into an L shape 
and use Orthogonal views to sculpt your 
model to fit the images.  
Text – Adds a text string as a 3D object. If 
you click on the box to the right of Text you 
will get a pop-up options box. Here you can 
enter your text string, the name of any 
TrueType font you have on your system, the 
directory where the font resides 
(C:\windows\fonts for example) and the 
number of edge bisections to make. The 
more bisections you make, the more complex 
the model will be. I recommend you leave it 
set to zero at least for starters. OK will 
create the text as a fully 3D model in your 
workspace. Cancel will abort the operation. 
MORE – This brings up a sub-menu of 
additional primitives available in Wings. 
 Torus Knot – Originally a plug-in by 
Anthony D'Agostino (scorpius) it is now 
included as part of the standard Wings 
distribution. This simple plug-in creates a 
torus knot with the absolute minimum 
possible number of faces and vertices. It is 
meant to be used as an input "cage" for the 
Catmull-Clark subdivision algorithm. The knot 
was created with Blender by extruding a 
Bezier circle along the path of a NURBS 
curve. 
 Spiral – Loops (2 by default), 
segments (16 by default), Sections (8 by 
default). You can change the number of 
Loops, Segments and Sections by clicking on 
the Options Box on the right side of the 
menu. 
 Spring – Loops (2 by default), 
segments (16 by default), Sections (8 by 
default). You can change the number of 
Loops by clicking on the Options Box to the 
right. 
 UV Torus – A more sophisticated 
version of the torus. Here you can specify 
the U Resolution (80 by default), the V 
Resolution (16 by default), the Major Radius 
(1.0 by default) and the Minor Radius (0.2 by 
default) by clicking on the box on the right of 
the menu. 
 Lumpy Torus – A variant of the UV 
Torus that adds two more parameters; 
Lumps (8 by default) and Lump Amplitude 
(0.5).  
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 Spiral Torus – another variation on 
the UV Torus. Here you have parameters for 
Loops and Loop Radius instead of Lumps and 
Lump Amplitude. All of these More primitives 
are used rarely, but can be used to great 

effect if you remember they are there. You 
will need to play around with the settings to 
get a good feel for how to create them, and 
how to use them effectively. 
 

 
 

 

Figure 45a: The Wings primitives. Top row from 
left to right; Tetrahedron, Octahedron, Octotoad, 
Dodecahedron, and Icosahedron.  

Second row; Cube, Cylinder, Cone, Sphere, and 
Torus. Third row; Grid, Image, Light and Text. 
Bottom row; Torus Knot, Spiral, Spring, UV Torus, 
Lumpy Torus, and Spiral Torus. 
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5.2.2 The Vertex Operations Menu 

Vertex Operations Menu – 

General 

If one or more vertices are selected right 
clicking in the workspace will bring up the  
Vertex Operations Menu. This will allow you 
to perform operations unique to vertex 
manipulations. 

VERTEX MENU | MOVE 
 Normal – moves the selected 
vertex/vertices along their normal. A normal 
is a vector (line of direction) that runs out 
perpendicular to the reference element. 
 Free – Will move the selected 
vertex/vertices in the direction of mouse 
movement. This can be very useful when in 
Orthographic mode, since it allows you to use 
the mouse to move vertices in two cardinal 
directions while "locking" out movement in 
the third. 
 X – constrains movement along the x 
axis. 
 Y – constrains movement along the y 
axis. 

 Z – constrains movement along the z 
axis. 
 
VERTEX MENU | ROTATE – Vertices 
will rotate about one center of mass for the 
entire selected set whether or not they are 
adjacent. Note that this works fundamentally 
differently than how faces or edges rotate. At 
least two vertices must be selected for this 
to have any effect at all. 
 Free – Will rotate the selected 
vertices in the direction of mouse movement. 
 X – constrains rotation about the x 
axis. 
 Y – constrains rotation about the y 
axis. 
 Z – constrains rotation about the z 
axis. 

VERTEX MENU | SCALE 
Requires two or more vertices to have any 
effect. Scale operations work based on the 
center of mass of the selected set. 
 Uniform – Scales the distance 
between the vertices uniformly in all three 
directions at once.  
 X – Scales the distance between the 
vertices along the x axis. 
 Y – Scales the distance between the 
vertices along the y axis. 
 Z – Scales the distance between the 
vertices along the z axis. 
 Radial X (YZ) – Scales the distance 
between the vertices radially from their local 
geometric x axis; i.e. The distances in y and z 
are effected while x remains constant. 
 Radial Y (XZ) – Scales the distance 
between the vertices radially from their local 
geometric y axis so that the y dimension 
remains constant. 
 Radial Z (XY) – Scales the distance 
between the vertices radially from their local 
geometric z axis;  so that the z dimension 
remains constant. 
 

 

 

 

 

 

 

 

 

Figure 46: The Vertex Operations 
 pop-up menu. 
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VERTEX MENU | EXTRUDE 
Can be performed on one or more vertices. 
During the extrusion process you can use the 
plus and minus (+ -) keys to change the size 
of the extruded spike's base. 
 Normal – a "spike" type feature is 
extruded from each selected vertex along the 
vertex normals, thus creating new faces. 
 Free – the "spikes" are created in the 
direction of mouse movement. 
 X – the "spikes" are created along the 
X axis. 
 Y – the "spikes" are created along the 
Y axis. 
 Z – the "spikes" are created along the 
Z axis. 

VERTEX MENU | FLATTEN 
Requires two or more vertices to have any 
effect. 
 X – Flattens the selected vertices by 
averaging their position in the X direction. 
This has the effect of aligning selected 
vertices in the X plane. 
 Y – Flattens the selected vertices by 
averaging their position in the Y direction. 
 Z – Flattens the selected vertices by 
averaging their position in the Z direction. 

VERTEX MENU | CONNECT (C) 
Connects selected vertices with edges if they 
have a common face, or if the faces between 
vertices is contiguous. More than one set of 
connects can be performed at a time. Some 
applications require triangles, rather than 
quads on import. You can convert your 
Wings quads to triangles very simply by 
selecting the Body, then pressing V to switch 
to vertex mode. All vertices on the model will 
then be selected. Then just do a Connect, 
and all the quads will be turned into triangles. 

VERTEX MENU |  TIGHTEN 
Tighten deserves a bit of explanation as it is 
not immediately obvious just what it does. 
Tighten looks at each vertex and works out 
the direction they need to move in so as to 
create the most tension-free surface. It then 
allows you to interactively move those 
vertices along that direction by dragging the 
mouse left and right. 

 
Another way to think of it is as a tool to get 
all the edges as similar in length as possible. 
It will eventually smooth out your model into 
an amorphous blob. 
 
You can use it to gently smooth out regions 
where you've made changes in the surface 
too harsh, by tightening select areas by small 
amounts. 
 
You can get your model into a more UV-
friendly paintable state by tightening a lot, 
thus avoiding areas where there's overhang 
or creases. 
 
Alternatively, you can tighten in the opposite 
direction (un-tighten) by small amounts where 
your surface is too smooth. It will make 
differences in edge length more extreme. If 
you find a model is coming out too gooey 
when smoothed, un-tighten it a bit before 
smoothing, it might help. 
 
Tighten may work slightly differently from 
Nendo®. Wings calculates all directions 
once, before the drag is started. Nendo® 
might recalculate all directions after every 
mouse move. (It would probably make a 
difference if adjacent vertices are selected, 
which they usually are.) 

VERTEX MENU | BEVEL 
Bevels corners at selected vertices, thus 
creating new faces. It has no effect on 
isolated vertices where two edges fail to 
intersect with any other (a single edge cut in 
two). Such vertices should be eliminated, by 
the way, via the Collapse tool. 

VERTEX MENU | COLLAPSE (Bksp) 
Removes the vertex, adjusting the faces and 
edges associated with it accordingly and 
leaves you in Face Selection Mode. 

VERTEX MENU | DISSOLVE  
Removes the vertex. Unlike Collapse, 
Dissolve leaves you in Vertex Selection Mode 
so that you can continue to select and 
eliminate vertices without having to switch 
back from Face Mode. 
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VERTEX MENU | DEFORM 
Wings3D has several deformation tools 
available, as listed below. 
 Crumple – moves selected vertices 
randomly. Good for adding "noise". 
 Inflate – moves selected vertices 
along their normal out from the center of 
mass of the selection. If you have a hollow 
object and select vertices on the inside as 
well as the outside of the object, Inflate will 
cause the vertices on the inside and outside 
to move outward just as if you were inflating 
a balloon. In other words, the outside 
vertices move on their positive normals while 
the inside vertices move on their negative 
normals. This can be a very powerful 
modeling tool. Note however that Inflate can 
cause faces to collide with each other, and 
can therefore ruin a model rather quickly. Be 
judicious in its use, especially in areas of 
dense geometry that may be oriented 
towards other parts of the model. 

 Taper (X, Y, Z) – will evenly spread 
the vertices apart radially along the selected 
axis. Note that the reference point for the 
Taper operation is at the middle of the 
model. 
 Twist (X, Y, Z) – This twists the 
selected vertices around an axis parallel to 
the chosen major axis. The axis will be pass 
through the center of bounding box for the 
selected vertices. Note that the 'anchor / 
stationary' end of the model always faces the 
negative side of any axis chosen. To twist 
round the other way, the model has to be 
rotated 180 degrees first. 
 Torque (X, Y, Z) – This twists the 
selected vertices around the chosen major 
axis (X, Y, or Z). Note that as with standard 
Twist, the 'anchor / stationary' end of the 
model always faces the negative side of any 
axis chosen. To twist round the other way, 
the model has to be rotated 180 degrees 
first. 

 

Some Examples: 
In the image below, Twist|Y and Torque|Y will do exactly the same thing. Both will twist the cylinder 
around the Y axis, because the cylinder is exactly centered in the middle of the workspace. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 47: Twist and Torque. A cylinder 
placed in the center of the workspace (a) 
exhibits exactly the same result (b) when 
subjected to either Twist|Y or Torque|Y. 
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In the image below, Twist|Y twists the off-
center cylinder around a vertical axis passing 
through the center of the cylinder. Torque|Y 
on the other hand will twist the cylinder 

around the workspace Y axis, yielding 
different results. 
 

 
 
You can achieve dramatically different results 
between Twist and Torque on asymmetrical 
objects. In the example below we have a 
cylinder that is centered in the workspace. 
One set faces has had an Extrude Region | 
Normal applied to make the object 

asymmetrical (a). In (b) we have applied a 
Twist | Y by 180 degrees. You can see that 
it caused the cylinder itself to become bent. 
In (c) we have applied a Torque | Y by 180 
degrees and get an interesting screw like 
object with a straight shaft. 

The above examples were kindly provided by Björn Gustavsson. 

Figure 48: Twist vs. Torque. A cylinder is moved off center in Z by 1 unit (a). 
Then a Twist|Y by 180 is applied. The result is exactly as in Figure 47. An Undo 
converts it back to a standard cylinder (a), and then Torque|Y by 180 is 
applied. The results are completely different. 

Figure 49: Other factors. If your object is asymmetrical, Torque can give you better 
results. 
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Quick Tip: Experiment with 
Deformers 
Deliberately moving models off center and 
experimenting with Twist and Torque can give 
'interesting' results. In my opinion, ensuring 
you have sufficient 'sections' along the length 
of your model is essential for producing 
satisfactory results. For non-organic / 
technical models, careful choice (and 
matching) of the number of linear and radial 
sectors can result in geometry that offers 
considerable scope for polygon reduction 
after twisting is complete. Experimentation 
and keeping away from prime numbers can 
pay dividends in this area if low polygon 
counts are needed. Rotating the model off a 
main axis and twisting at right angles to the 
models main axis can often prove an 
entertaining (and fruitful) exercise. If you 

want to 'dirty up' an object that's been 
twisted (for maybe a more 'organic' look) try 
selecting sections of the twisted item (rather 
than the whole) and re-applying a bit more 
twist. 
Taper operates from the center of the 
selection set along the axis chosen. One end 
will Taper up while the other end Tapers 
down. Like twist, experiment with selecting 
parts rather than the whole of the model - it 
is quite easy to get useful shapes this way. 
Successive applications of taper should also 
be tried - e.g. tapering a multi-sectioned 
cylinder 100% in Y and then repeating the 
op will produce a concave spike, like a 
Chinese hat whereas, if you perform the 
second taper  by -100% you get a beer 
barrel shape. 
Tip provided by Puzzled Paul 
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Both Models by Erin McClellan. 
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5.2.3 The Edge Operations Menu 

Edge Operations Menu – 
General 

If one or more edges are selected, right 

clicking in the workspace will bring up the 
Edge  
Context Sensitive Menu. This will allow you to 
perform operations unique to edge 
manipulations.  
 

EDGE MENU | MOVE 
 Normal – moves the selected 
edge/edges along their normal.  
 Free – Will move the selected 
edge/edges in the direction of mouse 
movement. This can be very useful when in 
Orthographic mode, since it allows you to use 
the mouse to move edges in two cardinal 
directions while "locking" out movement in 
the third. 
 X – constrains movement along the x 
axis. 

 Y – constrains movement along the y 
axis. 
 Z – constrains movement along the z 
axis. 

EDGE MENU | ROTATE 
Connected edges will rotate about their 
collective center of mass. Non-connected 
edges will rotate about their individual 
centers of mass. 
 Free – Will rotate the selected 
edge/edges in the direction of mouse 
movement.  
 X – constrains rotation about the x 
axis. 
 Y – constrains rotation about the y 
axis. 
 Z – constrains rotation about the z 
axis. 

EDGE MENU | SCALE  
Increases or decreases the length of the 
selected edges. 
 Uniform – Scales the selected edges 
uniformly in all three directions at once.  
 X – Scales the distance of the edges 
along the x axis. 
 Y – Scales the distance of the edges 
along the y axis. 
 Z – Scales the distance of the edges 
along the z axis. 
 Radial X (YZ) – Scales the length of 
selected edges radially from the x axis; i.e. 
The distances in y and z are effected while x 
remains constant. 
 Radial Y (XZ) – Scales the length of 
selected edges radially from the y axis so 
that the y dimension remains constant. 
 Radial Z (XY) – Scales the length of 
selected edges radially from the z axis;  so 
that the z dimension remains constant. 
 

EDGE MENU | EXTRUDE 
As with vertex extrusions you can use the 
plus and minus (+ -) keys to increase or 
decrease the base area of the extrusion. 

Figure 50: The Edge 
Menu. 
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 Normal – extrudes the selected edge 
or edges along their normal(s). 
 Free – Will extrude the selected 
edge/edges in the direction of mouse 
movement. 
 X – constrains the extrusion along the 
x axis. 
 Y – constrains the extrusion along the 
y axis. 
 Z – constrains the extrusion along the 
z axis. 
When you extrude an edge, new faces are 
created to connect the line to the main body 
of the object it is being extruded from. That 
is to say, the result will have thickness, you 
cannot create a "sheet" that protrudes from 
the object. 

EDGE MENU | CUT 
 2 – one edge is cut into two edges. 
 3 – one edge is cut into three edges. 
 4 – one edge is cut into four edges. 
 5 – one edge is cut into five edges. 
 10 – one edge is cut into ten edges. 
Cuts the selected edge(s) into the number of 
equally sized segments as specified by the 
number chosen from the side bar menu. 
Note that the number keys on the main 
keyboard can be used in lieu of the Cut 
command. The keys allow for an edge to be 
cut into 2 – 10 (0 being 10) segments by the 
simple press of a key. 

EDGE MENU | CONNECT C 
New edges are created that connect the 
selected edges together. Multiple edges can 
be connected at a time.  

EDGE MENU | BEVEL 
Creates a bevel, or chamfer, on selected 
edges. If used on an edge in the middle of a 
flat face, Bevel will open up a new face within 
the original face, on the same plane. Bevels 
interact with one another, so that if you have 
adjacent edges selected and then Bevel 
them, the new chamfered edges will join 
properly. Many renderers do not work well 
with large flat straight edged surfaces, 
causing artifacts to show up in textures and 
cast shadows. These side effects can be 
reduced, or even completely eliminated, if 
you apply a very slight bevel to all such harsh 
edges. Slight bevels will also help maintain 

the objects shape when you subdivide the 
object with the Smooth command. 

EDGE MENU | DISSOLVE (Bksp) 
Dissolve can be used to eliminate unwanted 
edges to refine your model or in preparation 
for other commands. Be careful in the use of 
Dissolve, for it can destroy the topological 
relationships between elements (and thus the 
model) very easily. 

Quick Tip: Creating round eyes 
from square holes. 
You can create roundish eyes from the 
results of a Vertex | Bevel by using a 
combination of Edge | Dissolve and Face | 
Smooth commands. To demonstrate this, 
create a cube and connect the left and right 
edges of one of its sides. Then Connect the 
three horizontal edges of that side to form a 
square cross intersection in the middle of 
the face. Select the vertex of the intersection 
and Bevel it to form a diamond shape in the 
middle of the face. With the face selected do 
a Smooth. Now select the four edges within 
the smoothed area and Dissolve them. You 
now have a roundish single face in the middle 
of the cube from which you can now extrude 
and scale several times to create an eye. 

EDGE MENU | COLLAPSE 
Collapse will eliminate an edge by snapping 
the vertices on each end together. This is 
the same effect of Weld Vertices found in 
many modeling programs. It can be used 
very effectively in conjunction with Select | By 
| Short Edges to remove microscopic edges 
that are interfering with your modeling. 

EDGE MENU | HARDNESS 
 Hard 
 Soft 
Edges can be Hard or Soft. They are soft by 
default. Hard edges are not moved when a 
model is smoothed, and therefore are handy 
for maintaining sharp edges where they are 
needed in a model to maintain overall shape. 
To make an edge hard, select it then from 
the Edge Menu choose Hard. To set it back 
to soft, choose Soft. If you have a lot of 
edges you want to make Hard, you can use 
the Object Menu | Auto Smooth which sets 
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all edges at sharp angles to hard, then use 
the Edge Menu | Soft to set selected edges 
back to soft. 

Quick Tip: Replace your hard edges 
with bevels. 
Not all renderers or other modeling 
programs can handle hard edges. Therefore 
it is generally agreed that they should not be 
used, especially in the final model. But that 
does not mean that they can not be used 
effectively during the modeling process. It is 
sometimes useful to set some edges as hard 
to hold the local form on a given area of a 
model and the do a Smooth. You can then 
continue to work the model. Once you are 
done, do a Select By | Hard Edges and then 
apply a slight Bevel. If you find that your 
bevels do not hold the form true after a 
sample smooth it probably indicates an area 
of the model in need of more geometry. Try 
adding some additional edges near the bevels 
and do another test smooth. Now the bevels 
should hold the form of the model true while 
eliminating the hard edges from the final 
model. 

EDGE MENU | LOOP CUT 
This is one of the most important commands 
in Wings. If you have a complete edge loop 
that closes on itself you can cut the model in 
two with Loop Cut. For example, if you have 
an edge loop that completely encircles the 

arm at the shoulder, you can select that 
edge loop, and do a Loop Cut to sever the 
arm from the model. Then you can work with 
both parts independent of one another or 
even save one part out as a separate model. 
This can also be useful in symmetrical 
modeling. If you create your rough model 
with a clean central edge loop, you can 
develop detail on one side of the model, then 
periodically Loop Cut the model, delete the 
non detailed side, and then Mirror the 
detailed side to quickly duplicate all the detail 
from one side to the other. This can be a 
great time saver. 

EDGE MENU | TURN 
This command is intended to be used on 
models that have been triangulated. It can 
easily destroy models made of quads, so be 
careful when and how you use it. Some 
programs, such as game engines, expect 
models to be composed entirely of triangles. 
But the overall shape of a model can be 
determined by how those triangles are laid 
out. Turn lets you create a better flow for the 
edges so that you can fine tune triangulated 
models. 

EDGE MENU | OPTIMIZED TURN 
Optimized Turn will triangulate your model by 
finding the shortest edges possible to create 
the triangles. 
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5.2.4 The Face Operations Menu 

Face Operations Menu – 
General 

If one or more faces are selected, right 
clicking in the workspace will bring up the 
Face  
Operations Menu. This will allow you to 
perform functions unique to face 
manipulations.   

FACE MENU | MOVE 
 Normal – moves the selected face or 
faces along their normal(s).  
 Free – Will move the selected faces 
in the direction of mouse movement. This 
can be very useful when in Orthographic 
mode, since it allows you to use the mouse 

to move faces in two cardinal directions while 
"locking" out movement in the third. 
 X – constrains movement along the x 
axis. 
 Y – constrains movement along the y 
axis. 
 Z – constrains movement along the z 
axis. 

FACE MENU | ROTATE  
Connected faces (Regions) will rotate about 
their collective center of mass. Non 
connected faces will rotate about their 
individual centers of mass. 
 Free – Will rotate the selected faces 
in the direction of mouse movement. 
 X – constrains rotation about the x 
axis. 
 Y – constrains rotation about the y 
axis. 
 Z – constrains rotation about the z 
axis. 

FACE MENU | SCALE 
 Uniform – Scales the face uniformly in 
all directions at once.  
 X – Scales the face in the x axis. 
 Y – Scales the face in the y axis. 
 Z – Scales the face in the z axis. 
 Radial X (YZ) – Scales the face 
radially from the x axis; i.e. The distances in y 
and z are effected while x remains constant. 
 Radial Y (XZ) – Scales the face 
radially from the y axis so that the y 
dimension remains constant. 
 Radial Z (XY) – Scales the face 
radially from the z axis; so that the z 
dimension remains constant. 

FACE MENU | EXTRUDE 
 Normal  – extrudes the selected 
face(s) along their normal(s). By extruding in 
the negative normal direction you can create 
indentations into the body of the object, such 
as a mouth or nostrils. 
 Free  – will extrude the selected 
face(s) in the direction of mouse movement. 
 X – constrains the extrusion along the 
x axis. 

 
Figure 51: The Face Menu. 
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 Y – constrains the extrusion along the 
y axis. 
 Z – constrains the extrusion along the 
z axis. 

FACE MENU | Extrude Region 
 Normal  – extrudes the selected 
face(s) along their normal(s) as a unit. By 
extruding in the negative normal direction you 
can create indentations into the body of the 
object, such as a mouth or nostrils. By using 
Extrude Region on a group of faces rather 
than simply using Extrude, you keep the faces 
joined together into one coherent surface, 
which is often preferable to having distinct 
stems "growing" out of the object. 
 Free  – will extrude the selected 
face(s) in the direction of mouse movement. 
 X – constrains the extrusion along the 
x axis. 
 Y – constrains the extrusion along the 
y axis. 
 Z – constrains the extrusion along the 
z axis. 

FACE MENU | EXTRACT REGION 
 Normal – extract faces and then 
move the faces along the regions normal. 
 Free – extract faces and then move 
faces freely in all directions. 
 X – extract faces and then move 
them along the X axis. 
 Y – extract faces and then move 
them along the Y axis.  
 Z – extract faces and then move 
them along the Z axis. 
Extracts a region, or group of faces, from 
the parent object to create a completely new 
object. Note that the faces do not have to be 
contiguous. To create a new object that 
abuts the original object do an Extract Region 
and immediately left click without moving the 
mouse, to lock it in place. You probably will 
not be able to successfully select the new 
object due to the underlying original and may 
have to use the Hide function in the Object 
enu to hide the parent object so that you can 
work with the new object. If you have created 
a new object from non abutting faces and 
want to work with them as separate objects, 
then use the Separate command to break 
them into their component parts.    

FACE MENU | FLATTEN 
 Normal 
 X 
 Y 
 Z 
 Last Axis 
 Default Axis 
 Region 
Sometimes faces can become non-planar as 
you work with your model, especially if you 
Move vertices. This can cause problems 
latter. One way to fix a non-planar face is to 
Flatten it, i.e., get all of its vertices onto the 
same plane. Smoothing the model will also 
create planar faces, but if you do not want to 
smooth your model, you can Flatten offending 
faces. It is also good for setting up geometry 
for further manipulation, so that extrusions 
go in the direction you want them to go, for 
example. 
 
If you have a default axis defined (see Tools | 
Set Default Axis) you can flatten to that axis 
or you can flatten to the last axis used. 
Flatten Region will flatten the edge loop, the 
boundary between selected and non-selected 
faces, of the selected faces. Note that the 
vertices on the edge loop become planar, not 
the faces contained therein. 

FACE MENU | INSET 
This creates a new face, of the same shape, 
inside the selected face. It works on one or 
more faces at a time, creating a new face 
for each of the selected faces. This could be 
used, for example, to create a picture inside 
a picture frame. The inner face could then be 
extruded in the negative direction to cause 
the frame to stand out. You can also Inset 
and make the new face larger than the 
original face. See the Dog House Tutorial in 
Section 3 of this manual for an example of 
this in action. 

FACE MENU | INTRUDE 
You can make some very cool models very 
quickly with the intrude function. It is 
especially handy for making lattice work type 
of objects, such as the Eiffel Tower or a bird 
cage. It works by creating an inverted copy of 
the entire object, then doing a Bridge on all 
pairs of selected faces. The thickness of the 
walls is controlled by how far you move the 
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mouse during the operation. The Dog House 
tutorial in this manual demonstrates the 
Intrude function quite nicely. 

FACE MENU | BEVEL 
Bevels all the edges of the selected face or 
faces simultaneously, thus creating a smaller 
selected face and small surrounding faces. 

FACE MENU | BRIDGE 
Causes two co-planer or nearly co-planar 
faces to snap together, thus fusing new 
geometry between them. Only two faces can 
be selected at a time for Bridge. The faces 
must have the exact same number of edges 
and vertices but can be shaped differently. 
This can be used to attach one object to 
another, one part of the same object to 
another part of the same object, or to create 
holes in an object if the selected faces are on 
opposite sides of the object. 

FACE MENU | BUMP 
Moves selected faces out along their 
normals while at the same time creating new 
faces that meld into the existing geometry via 
newly beveled faces that are created. This is 
great for building up muscle tone on a model. 

FACE | LIFT 
The Lift Command is only available if 
Advanced Menus are activated. Therefore, 
Lift will be discussed in the Advanced Menus 
section. 

FACE | PUT ON 
The Put On command allows you to drop one 
object onto another, much like dropping a 
box to the ground. Select the face you want 
to put onto another object then select Put On 
from the Face Menu. The Icon Bar will 
change to show you that you can select a 
vertex, edge or face to put the object on. 
Select the vertex, edge, or face you want and 
then Right Click to execute. The first object 
will jump into place right on the vertex, edge, 
or face you selected on the second object. 
This can be very useful when you go to weld 
parts together with the Bridge command. 

Quick Tip – Put On and Bridge 
To perform a bridge-like function at the same 
time, select both faces prior to Put On and 
Store | Selection. Use Put On, then Recall | 
Selection, Bridge, Cleanup, etc. This is quite 
quick, especially if on hot keys.  
Tip provided by puzzeled paul. 

FACE MENU | MIRROR 
Mirrors an object around one or more 
selected faces. By choosing multiple faces to 
perform Mirror multiple mirrors are 
performed simultaneously in the direction 
each face points. Thus care must be 
exercised on complex models least self 
colliding geometry be created. The Mirror 
command is most effective for doing 
symmetrical modeling, wherein only half of a 
model is built, then a mid model face is 
selected and Mirror used to create the other 
half of the model. If you maintain a clean 
central edge loop while modeling you can 
model, Mirror, continue to model, select the 
middle edge loop and do a Loop Cut, Delete 
the half of the model that needs to be 
updated, and then Mirror again. 

Quick Tip: Fix that mirror plane. 
If you use the Loop Cut, model, and Mirror 
method described above you will sometimes 
find that the object does not Mirror back 
together properly. This is often caused by the 
mirror face getting out of kilter i.e. non-
planar, while modeling. Mirroring in such 
cases will cause a real mess. To fix it up, 
select the mirror face and do a Flatten on 
the appropriate axis to make it planar again. 
Then do the Mirror to make a whole object 
from the half. Finally, select Tools | Center All 
to get the whole thing re-centered in the 
workspace.  
 

FACE MENU | DISSOLVE (Bksp) 
Deletes inner faces in a region of faces. You 
can also slice an object into several parts 
with the Dissolve command by selecting the 
faces that would separate the parts and 
doing a Dissolve. The parts will still be 
grouped as one object until you use the 
Separate command (in Object selection 
mode) to separate them. 
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FACE MENU | COLLAPSE 
Deletes the selected faces, replacing each 
face with a vertex. The selection mode will be 
changed to Vertex, and the newly created 
vertices will be selected, allowing you to apply 
further commands. 

FACE MENU | SMOOTH (S) 
Connects all the edges of a face and tightens 
up the vertices so as to form a smoother 
shape from the original face. You can make 
round eyes from square faces with Smooth. 

Quick Tip: Smooth To Check For 
Anomalies. 
To check for self colliding 'internal' 
geometry smooth once and eyeball in 
wireframe mode, as it won't usually be 
obvious as an unsmoothed wireframe. 
 
Tip provided by puzzeled paul. 

FACE MENU | SET MATERIAL 
 New – Will prompt you for a Material 
Name in a pop-up dialog. Type in a new name 
of your choice and click OK. This will bring up 
the Material Editor as pictured here. 
 
Here you can custom design a material to be 
applied to the selected face by setting the 
properties Diffuse, Ambient, Specular, 
Emission, Shininess, and Opacity. The ball on 
the left will show a preview of your material 
design and starts out as a neutral gray. To 
change any of the first four settings simply 
click on the box to bring up a color mixer. In 
the color mixer you can type in the RGB 
values in the fields 
on the left or use 
the slider bars to 

interactively mix the color. Once satisfied, 
click on OK. The ball on the left will 
immediately change to reflect your settings. 
Click OK again when you have finished 
adjusting all the settings to your liking. The 
new material will be added to the list of 
materials along with Default and Hole, with 
the name that you gave it. This new material 
can then be applied to any face selection you 
choose with the Face | Set Material 
command. The materials are saved with the 
model. In order to see it properly you will 
need to look at your model as Smooth 
Shaded, which you can do by pressing the 
Tab key. Note that a File | New will purge the 
materials list. 
 Default – will set the selected faces 
to the Default material color. 
 Hole – will set the selected faces to 
the Hole material color. 

FACE | TESSELATE 
 Triangulate – Will convert all the 
polygons in the selected faces to triangles. 
Some programs, such as game engines, 
expect models to be triangulated before 
import. 
 Quadrangulate – Will fix n-gon faces 
by converting them to quads whenever 
possible or to triangles if necessary. An n-
gon is a polygon with more than four edges. 
These are generally considered bad things to 
have in your model. This is often useful 
following a Face | Smooth since that type of 
smooth operation can result in adjoining n-
gon faces.   
 
 

Figure 52: The Wings Material Editor. Materials are assigned to faces, 
and therefore initially defined with the Material Editor accessed under the 
Face Menu. They can later be edited via the Material Editor accessed 
under the Edit Menu. 
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5.2.5 The Object Operations Menu 

Object Operations Menu – 
General 

OBJECT MENU | MOVE 
 Free – Will move the selected object 
or objects in the direction of mouse 
movement. This can be very useful when in 
Orthographic mode, since it allows you to use 
the mouse to move objects in two cardinal 
directions while "locking" out movement in 
the third. 

 X – constrains movement along the x 
axis. 
 Y – constrains movement along the y 
axis. 
 Z – constrains movement along the z 
axis. 

OBJECT MENU | ROTATE 
 Free – Will rotate the selected 
object(s) in the direction of mouse 
movement.  
 X – constrains rotation about the x 
axis. 
 Y – constrains rotation about the y 
axis. 
 Z – constrains rotation about the z 
axis. 

OBJECT MENU | SCALE 
 Uniform – Scales the object uniformly 
in all  directions at once.  
 X – Scales the object along the x axis. 
 Y – Scales the object along the y axis. 
 Z – Scales the object along the z axis. 
 Radial X (YZ) – Scales the object 
radially from the x axis; i.e. The size in y and 
z are effected while x remains constant. 
 Radial Y (XZ) – Scales the object 
radially from the y axis so that the y 
dimension remains constant. 
 Radial Z (XY) – Scales the object 
radially from the z axis;  so that the z 
dimension remains constant. Figure 53: The 
Body or Object Menu. 

OBJECT MENU | FLIP 
 X – will flip the object on the X axis. 
 Y – will flip the object on the X axis. 
 Z – will flip the object on the X axis. 

OBJECT MENU | INVERT 
Invert will flip all the normals of the model, in 
effect turning it inside out. This can be useful 
if an imported model loads into Wings 
inverted, i.e., the normals all pointing 
inwards instead of outwards. Invert will fix 
the normals so that they all point outward. It 
can also be useful to fix model parts that are 
created via Extract Region on inward facing 

Figure 53: The Object Menu. If one or
more objects are selected, right clicking in
the workspace will bring up the Object
Operations Menu. This will allow you to
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regions, though it may take some getting 
used to working inverted. 
 
Quick Tip: A way to create the 
juice object inside a glass and have 
it line up. 
On the inside of a glass or jug create a loop 
that defines the height of the liquid. Then 
select the loop, do a Shift-L to select the 
region next to it (Ctrl-Shift-I if it selects the 
wrong side). Do an Extract Region, Normal,  
and click without moving. This will separate 
off that area and make it solid. Switch to 
Body Mode (B), then do an Invert, which will 
flip the normals to align correctly. You now 
have a separate juice object that fits the jug 
exactly. 
Tip provided by Mestela. 

Quick Tip: Invert vs. Intrude.  
With Intrude you can create a hollow object 
but the inside will be the same shape as the 
outside. Invert, on the other hand, can be 
useful to create an object that has a different 
shape on the inside than on the outside, 
connected via a bridged tunnel. Using invert, 
can put a totally different object inside 
another, invert the inner object, and bridge a 
tunnel between inner and outer objects, to 
get different inner/outer volumes. 
Tip provided by PuzzledPaul 

OBJECT MENU | TIGHTEN 
This will move all the vertices of an object 
towards each other, or away from each 
other. The effect is to round out or "soften" 
the model with a slight Tighten, or 
exaggerate the angles if you "un-tighten". 

OBJECT MENU | SMOOTH (S) 
This smoothes the model by performing a 
Catmull-Clarke subdivision on all the faces. 
This will have the effect of smoothing out 
angles between faces if they have not been 
set to hard, and eliminates poles by creating 
clean quad topology. If you want to maintain 
sharp angles in your model be sure to set 
the necessary edges to hard, either via the 
Edge Menu Hardness command, or by first 
doing an Auto-Smooth.  

OBJECT MENU | COMBINE 
This will combine the selected objects into 
one object. Unlike Mirror, it does not actually 
fuse or change any geometry. This can be 
very useful if you have a model composed of 
several parts and want to Scale, or Rotate 
them as a single entity. If you scale such a 
model without first using Combine, the parts 
will either pull away from each other or  
collide with each other since they all have 
their own local origins. Combine will allow you 
to scale everything together as if it were all 
one object, because they do indeed become 
one object. Objects need not be touching or 
even near each other to be combined. Object 
names previously assigned are lost. 

OBJECT MENU | SEPARATE 
If two or more objects have been fused via 
the Combine command, this will Separate 
them into their component parts. Former 
names will not be reestablished. Bodies that 
were separated by a Face | Dissolve 
operation can also be separated into 
separate bodies. 

OBJECT MENU | CLEANUP 
This command will find all non-intersecting 
vertices in the model and Collapse them. 
Good for maintaining the topological integrity 
of the model. 

OBJECT MENU | AUTO-SMOOTH 
This command will find all edges formed by 
sharp angels and automatically set them to 
be hard edges. Then when you Smooth the 
object, it will retain much of the original form 
and detail. By default the edge will be set to 
hard if the angle between the faces is more 
than 60 degrees. However you can set the 
crease angle by clicking on the parameters 
box to the right on the menu to suite your 
own needs. 
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OBJECT MENU | DUPLICATE 
Creates a copy of the selected object. 
Moving the mouse before doing another click 
will move the copy in the desired direction as 
chosen in the sub-menu; Free, X, Y, or Z. 
 Free – Moves the newly created 
object in the direction of mouse movement. 
 X – The newly created object will 
move in +X or -X directions only. 
 Y – The newly created object will 
move in +Y or -Y directions only. 
 Z – The newly created object will 
move in +Z or -Z directions only. 

OBJECT MENU | DELETE (Bksp or 
Del) 
Will delete one or more selected objects. 
They can be recalled via Undo. 

OBJECT MENU | MODE 
This lets you shift from Vertex Color mode to 
Material mode on selected objects. Note that 
objects that have UV Texture coordinates 
cannot be shown with vertex colors. 

OBJECT MENU | STRIP TEXTURE 
This will strip the textures from an imported 
model. 

OBJECT MENU | UV MAPPING 
(experimental) 
This brings up the AutoUV utility, a 
subprogram to Wings3D. To execute AutoUV 
select the whole object you want to map and 
then choose UV Mapping (experimental) from 
the Object menu. The Wings geometry 
window will change to have only three icons 
at the top; Vertex, Edge, and Face selection 
icons. Furthermore, right clicking in the 
workspace will bring up a new menu (the 
AutoUV Menu). It is not immediately 
apparent what you need to do to work with 
AutoUV, so this and the next several posts 
will explore what the AutoUV options are and 
how to use them. Since AutoUV is 
experimental, all of this is, of course, subject 
to change. The next section will explain the 
use of this complex tool. 

 



Section 5.3 Advanced Men  WINGS3D USER MANUAL 

88 DRAFT 1.6  

 5.3 Advanced Menus 
We have put off discussion of advanced 
menus because it is generally agreed that 
new uses are best off leaving them alone 
until they have a firm grasp of basic Wings 
operations. However, I strongly recommend 
that you become proficient with the basic 
operations quickly and turn Advanced Menus 
on, and then leave them on forever since 
they offer so much additional modeling 
capability. Here we will discuss the Advanced 
Menu system, explain the mechanics of their 
use, and detail the advanced menu options 
available to you. 
 
You can turn on the Advanced Menus by 
selecting that option in the Edit | Preferences 
Menu. After doing so you will see some 
changes to the Wings pop-up context 
sensitive menus. Most notably, the small 
sub-menu indicators on the right side of the 
menus change from small arrowheads to 

small dots. This is your visual clue that 
Advanced Menus are enabled. Also, the Lift 
command becomes available in the Face 
Operations menu.  
 
What Advanced Menus do for you is enable 
secondary selections. This does not sound all 
that significant at first, but it is. Just what a 
"secondary selection" is may need a little 
explanation. After making your primary 
selection, say you select an edge, normally 
you will be given options to manipulate that 
edge along its normal, free, or along the 
positive or negative X, Y, Z axis only. 
Sometimes you would like to use another 
axis, or vector, to work from. This is what 
enabling secondary selections does for you. It 
allows you to define just about any vector as 
the axis of operation for a given command. 
Consider the simple example presented in 
Figure 54. 
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In the top two panels are screen shots taken 
with the standard menus on. In 54.a you can 
see that we can move the selected vertex 
along its Normal, Free, or in the X, Y or Z 
directions only. 54.b shows the result of 
moving the vertex along X by 0.5 units. Now 
take a look at panel 54.c, where Advanced 
Menus have been turned on, and compare it 
to panel 54.a. Notice two things 

immediately. First the arrowheads in 54.a 
have become small dots in 54.c. Second, the 
messages on the status bar have changed 
dramatically. Be sure to pay attention to the 
status bar when modeling in Wings, 
especially when you have Advanced Menus 
on, for very important instructions are given 
there. In this case the status bar is telling 
you that a Left mouse click [L] will allow you 

Figure 54: Standard vs. Advanced Menus. 
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to move along the standard axis, just like 
normal, but that a Right mouse click [R] will 
allow you to select a user defined axis to 
move along. In panel 54.c we have clicked 
the Right mouse button and are now 
presented with a new interface which will 
allow us to make our secondary selections, 

which in turn, will define our new axis (often 
referred to as a vector). Notice that the icon 
bar has changed to indicate that you can 
select vertices, edges or even faces to define 
this vector and the status bar is giving you 
new instructions (Panel 54.d). Make your 
selections (you can use more than one 
element to define the vector) with the Left 
mouse button and then Execute with the 
Right mouse button. Panel 54.e shows the 
newly defined axis as a thick blue line passing 
through the vertex we chose as the vector. 
Finally panel 54.f shows the result of a move 
along that axis, also by 0.5 units. As you can 
see, you get very different results. Note that 
you can use another object completely on 
which to make your secondary selections, 

meaning that you can define virtually any 
vector with a bit of set up. It is also handy to 
note that if you only need one selection to 
define your vector you can use a single right 
click to select it and then drag to execute all 
at once. 
 

But that is not all that Advanced Menus do 
for you. By enabling Advanced Menus you 
also get access to the magnets in Wings. 
Remember in the example above we Right 
clicked on the Move command to enable 
secondary selections. We said if we left click 
we would get to work on standard axis only. 
But we also would see the magnets suddenly 
appear, as seen in Figure 55 below. 
  
With Advanced Menus enabled, on many of 
the commands a Left click will reveal the 
Wings magnets as seen in Figure 55.a 
above. If you click on the actual command 
(Normal, Free, X, Y, or Z) you will work as 
normal without the magnets. But if you click 
on the little magnet icon to the right of the 

Figure 55: The Wings magnets. 
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command, then you will enable the magnets. 
Also notice that important instructions are 
being passed to you via the status bar once 
again. 
 
In panel 55.a we have a vertex selected that 
we want to move but we want the movement 
to affect some of the surrounding vertices as 
well. So we left click on Move, which brings 
up the Move menu with magnets enabled. 
Then we hover over the magnet icon next to 
the X option and read the status line. The 
status bar tells us that we must use the left 
mouse button to define an area of influence, 
or fall off zone, for the magnet to affect, that 
a Middle mouse button click would allow us 
to enter a numeric radius as seen in Figure 
56, and that a Right mouse button would 
use the last radius used. We then use the 
Left mouse button and select a set of 
vertices not too far from the initial selection, 
in this case three (one hidden from our 
current view) which results in a big blue dot 
as seen in panel 55.c. This dot indicates the 
center of the extent of our fall off zone. Now 
the status bar is giving new instructions, 
specifically, that you can begin the magnetic 
move with the Right click of the mouse. 
Panel 55.d shows the result of doing a 
magnetic Move. Keep in mind that you can 
use of the Middle mouse button to dolly 
around during this operation to get a good 
look at things as you go. 

 
Further more, you can combine these two 
types of operations. You can define a vector 
and then Alt-Right Click to bring up a 
Vector+Magnet operation. Doing so bring up 
this little gem:  

 
 
Just click on the little magnet icon and set up 
magnets as described before. You get the 
power of both vectors and magnets 
combined. Note that for users of Maya 
camera mode, Hold Ctrl instead of Alt while 
right-clicking. (This is shown in the help 
prompt in the status line.) 
 
Finally, there is the new Face command, Lift, 
that becomes available when Advanced 
Menus are activated. The reasons Lift is only 
available with Advanced Menus is that it 
requires a secondary selection to use as the 
pivot for performing the lift. And secondary 
selections is what Advanced Menus are all 
about. Lift is explained in more detail in the 
following section. 

 

Figure 57: Vector 
Magnets revealed. 

Figure 56: The Influence Menu. Numeric entry of the 
magnetic fall off zone is accessed via the Middle mouse 
button. 
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5.4 A little tutorial. 
The first thing you need to do is make sure 
that you have Advanced Menus activated. 
Under Edit | Preferences make sure the 
Advanced Menus option (near the bottom of 
the form) is checked. Then click OK to return 
to the workspace. 
 
Create a cube and select the top face. Then 
right click in the workspace to bring up the 
Face Operations Menu. Now hover over 
Move. Don't click anything! 
 
Read the status bar and notice that a left 
click will use the standard axes whereas a 
right click will use custom vectors. I hope you 
have realized by now just how important the 
message passing in the status bar is. I 
cannot emphasis it enough. Click the Right 
Mouse Button to begin using vector 
operations. 
 
At the right of the status bar Wings will tell 
you to Select Axis for Face Move. This is how 
you will define the vector. Click on the 
positive Z face and notice the appearance of 
a blue vector. Now click on the positive X 
face and notice that the direction of the 
vector changed. You can continue to select 
and deselect faces until you get the vector 
going the way you want it to. You can even 
use a remote object for this vector definition 
process. 
 
Once you are happy with the direction of your 
vector then click the Right Mouse Button. 
Now you can move the mouse and watch the 
face move along the vector you just defined. 
Notice the instructions on the status bar as 
you are dragging. It now tells you that you 
can constrain the movement by holding down 
modifier keys while dragging. Dragging with 
the Shift key depressed will cause movement 
to be constrained to whole units, while the 
Ctrl key will cause movement to be 
constrained to tenths of units. That's it. You 
now know how to use Wings vector 
operations. Just try doing this a couple of 
times then try a few of the other commands. 
You'll have the routine down in no time. 
 
Now let's practice a little with magnets. 

 
Delete your cube and bring up a Grid 
primitive; right click to bring up the Primitives 
menu and look for Grid in the list of 
primitives. Don't click it, instead, click the 
option box on the right to specify how big we 
want our grid to be. A little pop-up box will 
ask you to specify the number of Rows/cols. 
Enter 20 and click OK. Grids are great for 
seeing the effects of magnets. 
 
Select a vertex four in from the +Z/+X 
corner as shown below (Figure 58.a). Now 
Right Click to bring up the Vertex Operations 
menu. Then Left Click on Move to bring up 
the options sub-menu (Figure 58.b). Click on 
the little magnet icon to the right of Normal. 
Now read the status bar and notice the icon 
bar has changed. At the right of the status 
bar Wings is telling you what you need to do 
while to the left it is telling you how to do it. 
Right now it is telling you that you need to 
select the magnet influence (fall-off zone) for 
the move operation and that you do this by 
Left Clicking some elements. The Icon bar is 
telling you that those elements can be 
vertices, edges or faces (with vertices being 
the default).  
 
The fall-off zone is defined as a radius from 
the initial selection point, so we only need to 
pick one other vertex to define it. Pick one 
that is four vertices away from the initial 
selection (Figure 58.c). It shows up as a big 
blue square on the +X edge of my grid in this 
case.  
 
Notice that the status bar is still telling us 
that a Right Click will execute the command. 
So let's Right Click now and see what 
happens when we move the mouse around. 
As you move the mouse around watch the 
status bar again. It will tell you by how much 
the original vertex is moving, but it also tells 
you the radius of the fall-off zone. But we 
already defined the radius, so what is that 
for? Well, you can change the fall-off zone 
radius interactively as you drag by using the 
plus and minus (+ -) keys as indicated on the 
right side of the status bar. Go ahead and 
press the Plus key a couple of times and see 
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what happens. After you have the feel for all 
this adjust the mouse until your D reads 
0.50 and your R reads 1.00 again. Your grid 
should now look like mine (Figure 58.d). 
 
Besides the plus/minus keys, you may have 
noticed the status bar indicates that the 
numeric keys 1, 2, 3, and 4 also do 
something. Furthermore, you may have 
noticed that the 2 option has <<braces >> 
around it. The braces indicate the type of 
magnet you  currently have implemented, in 
this case Dome. There are four types of 
magnets to choose from, Bell, Dome, 
Straight, and Spike; selected by their 
respective number key. So let's see what 
they look like. Work in the other three 
sectors of our grid and set up and execute a 
magnet as we did before, but this time, when 

dragging out the distance, 
press the number 1 on your 
keyboard to see the effect of 
a Bell magnet. End with the 
settings D: 0.50 and R: 1.00 
as before. Left click to 
complete the operation and 
then hit the Space Bar to 
clear the selection. Repeat 
the whole works again for 
Straight and Spike. Your final 
grid should come out looking 
something like mine (Figure 
58.e).  
 
Finally, let's combine the 
effect of Vector Operations 
and Magnets. 
Choose the central vertex in 
the grid and right click to 
bring up the Vertex 
Operations menu as before. 
This time Right Click on Move 
to bring up the Vector 
operations. Left click on the 
initial vertex (the one right in 
the center of the grid) and on 
the vertex at the top of the 
dome we created at the 
beginning of this tutorial. This 

will create a vector aiming towards the top of 
our dome.  Now Alt-Right Click to bring up a 
small menu. Notice that this menu has a 
magnet icon on it! Click on the magnet icon. 
Now click on a vertex to define the fall-off 
zone, again choose one about four vertices 
away from the initial selection point. Right 
click to execute and drag the mouse to the 
old familiar settings of D: 0.05 and R: 1.00. 
Whoa! It's going the wrong way, into the 
ground. So drag the mouse to D: -0.50 and 
R: 1.00 instead. Press the 2 button to 
change the magnet back to a Dome (the last 
one we did was Spike, so it was still 
selected). Left click to complete the 
operation and examine the model. It should 
look something like mine (Figure 58.f). 
 

Figure 58: Magnet operations in Wings. 
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5.5 Advanced Menu Command Reference Guide 
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5.5.1 Vertex Operations with Advanced Menus 

VERTEX | MOVE: Left Mouse 
Button (LMB) 
Select elements to define the vector, Right 
Mouse Button (RMB) = Execute the 
operation, and Alt Right Mouse Button (Alt-
RMB) to bring up the options sub-menu. First 
define the vector to move along with the 
LMB then execute with the RMB. To bring up 
the options menu A-RMB. This is where you 
can access magnets while working with 
vectors. Note that the Middle Mouse Button 
(MMB) can be used to dolly the camera while 
working. Subsequent moves can be made on 
the newly defined vector by choosing Last 
Axis from the standard Vertex Operations 
menu. 

VERTEX | ROTATE: LMB 
Select elements to define the vector, Right 
Mouse Button (RMB) = Execute the 
operation, and Alt Right Mouse Button (Alt-
RMB) to bring up the options sub-menu. As 
with Move, first define the vector to rotate 
about with the LMB then execute with the 
RMB. To bring up the options menu Alt-RMB. 
This is where you can access magnets while 
working with vectors. Note that the Middle 
Mouse Button (MMB) can be used to dolly 
the camera while working. Subsequent 
rotates can be made about the newly defined 
vector by choosing Last Axis from the 
standard Vertex Operations menu. 

VERTEX | SCALE: LMB 
Select elements to define the vector, Right 
Mouse Button (RMB) = Execute the 
operation, and Alt Right Mouse Button (Alt-
RMB) to bring up the options sub-menu. As 
with Move, first define the vector to scale on 
with the LMB then execute with the RMB. To 
bring up the options menu Alt-RMB. This is 
where you can access magnets while 

working with vectors. Note that the Middle 
Mouse Button (MMB) can be used to dolly 
the camera while working. Subsequent 
scales can be made about the newly defined 
vector by choosing Last Axis from the 
standard Vertex Operations menu. As with 
standard scaling, you must have at least two 
vertices in your initial selection to have any 
effect. 
 

Vertex | Extrude: LMB 
Select elements to define the vector, Right 
Mouse Button (RMB) = Execute the 
operation, and Alt Right Mouse Button (Alt-
RMB) to bring up the options sub-menu. As 
with Move, first define the vector to extrude 
on with the LMB then execute with the RMB. 
To bring up the options menu Alt-RMB. This 
is where you can access magnets while 
working with vectors. Note that the Middle 
Mouse Button (MMB) can be used to dolly 
the camera while working. Subsequent 
extrusions can be made about the newly 
defined vector by choosing Last Axis from the 
standard Vertex Operations menu. 
 

Vertex | Flatten: LMB 
Select elements to define the vector, Right 
Mouse Button (RMB) = Execute the 
operation, and Alt Right Mouse Button (Alt-
RMB) to bring up the options sub-menu. As 
with Move, first define the vector to flatten to 
with the LMB then execute with the RMB. To 
bring up the options menu Alt-RMB. This is 
where you can access magnets while 
working with vectors. Note that the Middle 
Mouse Button (MMB) can be used to dolly 
the camera while working. Subsequent 
flatten operations can be made using the 
newly defined vector by choosing Last Axis 
from the standard Vertex Operations menu. 

 

5.5.2 Edge Operations with Advanced Menus 
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Edge | Move: LMB 
Select elements to define the vector, Right 
Mouse Button (RMB) = Execute the 
operation, and Alt Right Mouse Button (Alt-
RMB) to bring up the options sub-menu. First 
define the vector to move along with the 
LMB then execute with the RMB. To bring up 
the options menu Alt-RMB. This is where you 
can access magnets while working with 
vectors. Note that the Middle Mouse Button 
(MMB) can be used to dolly the camera while 
working. Subsequent moves can be made 
using the newly defined vector by choosing 
Last Axis from the standard Vertex 
Operations menu. 

Edge | Rotate: LMB  
Select elements to define the vector, Right 
Mouse Button (RMB) = Execute the 
operation, and Alt Right Mouse Button (Alt-
RMB) to bring up the options sub-menu. As 
with Move, first define the vector to rotate 
about with the LMB then execute with the 
RMB. To bring up the options menu Alt-RMB. 
This is where you can access magnets while 
working with vectors. Note that the Middle 
Mouse Button (MMB) can be used to dolly 
the camera while working. Subsequent 
rotations can be made using the newly 
defined vector by choosing Last Axis from the 
standard Vertex Operations menu. 

Edge | Scale: LMB  
Select elements to define the vector, Right 
Mouse Button (RMB) = Execute the 
operation, and Alt Right Mouse Button (Alt-
RMB) to bring up the options sub-menu. As 
with Move, first define the vector to scale 
along with the LMB then execute with the 
RMB. To bring up the options menu Alt-RMB. 
This is where you can access magnets while 
working with vectors. Note that the Middle 
Mouse Button (MMB) can be used to dolly 
the camera while working. Subsequent 
scales can be made using the newly defined 
vector by choosing Last Axis from the 
standard Vertex Operations menu. 

Edge | Extrude: LMB  
Select elements to define the vector, Right 
Mouse Button (RMB) = Execute the 
operation, and Alt Right Mouse Button (Alt-
RMB) to bring up the options sub-menu. As 
with Move, first define the vector to extrude 
along with the LMB then execute with the 
RMB. To bring up the options menu Alt-RMB. 
This is where you can access magnets while 
working with vectors. Note that the Middle 
Mouse Button (MMB) can be used to dolly 
the camera while working. Subsequent 
extrusions can be made using the newly 
defined vector by choosing Last Axis from the 
standard Vertex Operations menu. 
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5.5.3 Face Operations with Advanced Menus 

FACE | MOVE: LMB  
Select elements to define the vector, Right 
Mouse Button (RMB) = Execute the 
operation, and Alt Right Mouse Button (Alt-
RMB) to bring up the options sub-menu. First 
define the vector to move along with the 
LMB then execute with the RMB. To bring up 
the options menu Alt-RMB. This is where you 
can access magnets while working with 
vectors. Note that the Middle Mouse Button 
(MMB) can be used to dolly the camera while 
working. Subsequent moves can be made 
using the newly defined vector by choosing 
Last Axis from the standard Vertex 
Operations menu. 

FACE | ROTATE: LMB  
Select elements to define the vector, Right 
Mouse Button (RMB) = Execute the 
operation, and Alt Right Mouse Button (Alt-
RMB) to bring up the options sub-menu. As 
with Move, first define the vector to rotate 
about with the LMB then execute with the 
RMB. To bring up the options menu Alt-RMB. 
This is where you can access magnets while 
working with vectors. Note that the Middle 
Mouse Button (MMB) can be used to dolly 
the camera while working. Subsequent 
rotations can be made using the newly 
defined vector by choosing Last Axis from the 
standard Vertex Operations menu. 

FACE | SCALE: LMB  
Select elements to define the vector, Right 
Mouse Button (RMB) = Execute the 
operation, and Alt Right Mouse Button (Alt-
RMB) to bring up the options sub-menu. As 
with Move, first define the vector to scale 
along with the LMB then execute with the 
RMB. To bring up the options menu Alt-RMB. 
This is where you can access magnets while 
working with vectors. Note that the Middle 
Mouse Button (MMB) can be used to dolly 
the camera while working. Subsequent scale 
operations can be made using the newly 
defined vector by choosing Last Axis from the 
standard Vertex Operations menu. 

FACE | EXTRUDE: LMB  
Select elements to define the vector, Right 
Mouse Button (RMB) = Execute the 
operation, and Alt Right Mouse Button (Alt-
RMB) to bring up the options sub-menu. As 
with Move, first define the vector to extrude 
along with the LMB then execute with the 
RMB. To bring up the options menu Alt-RMB. 
This is where you can access magnets while 
working with vectors. Note that the Middle 
Mouse Button (MMB) can be used to dolly 
the camera while working. Subsequent 
extrusions can be made using the newly 
defined vector by choosing Last Axis from the 
standard Vertex Operations menu. 

FACE | EXTRUDE REGION: LMB  
Select elements to define the vector, Right 
Mouse Button (RMB) = Execute the 
operation, and Alt Right Mouse Button (Alt-
RMB) to bring up the options sub-menu. As 
with Move, first define the vector to extrude 
along with the LMB then execute with the 
RMB. To bring up the options menu Alt-RMB. 
This is where you can access magnets while 
working with vectors. Note that the Middle 
Mouse Button (MMB) can be used to dolly 
the camera while working. Subsequent 
extrusions can be made using the newly 
defined vector by choosing Last Axis from the 
standard Vertex Operations menu. 

FACE | EXTRACT REGION: LMB  
Select elements to define the vector, Right 
Mouse Button (RMB) = Execute the 
operation, and Alt Right Mouse Button (Alt-
RMB) to bring up the options sub-menu. As 
with Move, first define the vector to extract 
the region along with the LMB then execute 
with the RMB. To bring up the options menu 
Alt-RMB. This is where you can access 
magnets while working with vectors. Note 
that the Middle Mouse Button (MMB) can be 
used to dolly the camera while working. 
Subsequent extractions can be made using 
the newly defined vector by choosing Last 
Axis from the standard Vertex Operations 
menu. 
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FACE | FLATTEN: LMB  
Select elements to define the vector, Right 
Mouse Button (RMB) = Execute the 
operation, and Alt Right Mouse Button (Alt-
RMB) to bring up the options sub-menu. As 
with Move, first define the vector to flatten to 
with the LMB then execute with the RMB. To 
bring up the options menu Alt-RMB. This is 
where you can access magnets while 
working with vectors. Note that the Middle 
Mouse Button (MMB) can be used to dolly 
the camera while working. Subsequent 
flatten operations can be made using the 
newly defined vector by choosing Last Axis 
from the standard Vertex Operations menu. 
 

FACE | LIFT:   
This is an Advanced Menu option only 
because it relies on a secondary selection to 
work. To use Lift, select a face you want to 
lift. Then click on Lift in the Face menu. Note 
the instructions on the status bar. Select a 
point or edge to act as the pivot for the lift 
operation with the Left mouse button. Then 
click the Right mouse button to execute the 
command. Control the amount of lift by 
moving the mouse to the right or left. 
Complete the operations with a left mouse 
click. Try it out a few times on a simple 
object with an Inset face. It is a very useful 
modeling tool. 
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5.5.4 Body Operations with Advanced Menus 

BODY | MOVE: LMB  
Select elements to define the vector, Right 
Mouse Button (RMB) = Execute the 
operation, and Alt Right Mouse Button (Alt-
RMB) to bring up the options sub-menu. First 
define the vector to move along with the 
LMB then execute with the RMB. To bring up 
the options menu Alt-RMB. This is where you 
can access magnets while working with 
vectors. Note that the Middle Mouse Button 
(MMB) can be used to dolly the camera while 
working. Subsequent moves can be made 
using the newly defined vector by choosing 
Last Axis from the standard Vertex 
Operations menu. 

Body | Rotate: LMB  
Select elements to define the vector, Right 
Mouse Button (RMB) = Execute the 
operation, and Alt Right Mouse Button (Alt-
RMB) to bring up the options sub-menu. As 
with Move, first define the vector to rotate 
about with the LMB then execute with the 
RMB. To bring up the options menu Alt-RMB. 
This is where you can access magnets while 
working with vectors. Note that the Middle 
Mouse Button (MMB) can be used to dolly 
the camera while working. Subsequent 
rotations can be made using the newly 
defined vector by choosing Last Axis from the 
standard Vertex Operations menu. 

Body | Scale: LMB  
Select elements to define the vector, Right 
Mouse Button (RMB) = Execute the 
operation, and Alt Right Mouse Button (Alt-
RMB) to bring up the options sub-menu. As 
with Move, first define the vector to scale 
along with the LMB then execute with the 
RMB. To bring up the options menu Alt-RMB. 
This is where you can access magnets while 
working with vectors. Note that the Middle 
Mouse Button (MMB) can be used to dolly 
the camera while working. Subsequent scale 
operations can be made using the newly 
defined vector by choosing Last Axis from the 
standard Vertex Operations menu. 

Body | Duplicate: LMB  
Select elements to define the vector, Right 
Mouse Button (RMB) = Execute the 
operation, and Alt Right Mouse Button (Alt-
RMB) to bring up the options sub-menu. As 
with Move, first define the vector to duplicate 
along with the LMB then execute with the 
RMB. To bring up the options menu Alt-RMB. 
This is where you can access magnets while 
working with vectors. Note that the Middle 
Mouse Button (MMB) can be used to dolly 
the camera while working. Subsequent 
duplications can be made using the newly 
defined vector by choosing Last Axis from the 
standard Vertex Operations menu. 
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5.6 Reference Guide to Hot Key Assignments 
Wings allows you to make your own hot key 
assignments. To do so select the operation 
you want to do, then with that operation still 
selected, hit the Insert key on your key 
board, then hit the key or key combination 
you want to use as the hot key for that 

command. Similarly, by pressing Delete on a 
command having a hot key, that hot key will 
be removed. Of course Wings comes with a 
number of hot key assignments already. The 
following is a quick guide to the predefined 
Wings hot keys.

 
 
Key Shift-Key Ctrl-Key Ctrl-Shift-Key Alt Alt-Ctrl-Key 

A = Aim A = View | Frame A = Select | All 
(Verts, Edges, 
Faces, or Objects) 

   

B = Body Mode      

C = Vertex | Connect  

C = Edge | Connect  

     

D = Edit | Repeat D = Repeat Drag     

E = Edge Mode      

F = Face Mode      

G = Select | Edge Ring      

      

I = Select | Similar   I = Select | Inverse   

      

      

L = Select | Loop L = Select | Region L = File | Merge    

      

  N = File | New    

O = Orthographic View  O = File | Open    

      

Q = tumble/track toggle in 
Mirai® and Nendo® camera 
modes. 

 Q = File | Quit    

R = View | Reset View R = Reset OpenGL     

S = Face | Smooth 

S = Body | Smooth 

 S = File | Save S = File | Save    

T = Edge | Turn      

U = View | Auto Rotate      

V = Vertex Mode      

W = View | Wireframe      

X = X axis view X = -X axis view     

Y = Y axis view Y = -Y axis view     

Z = Z axis view Z = -Z axis view Z = Edit | 
Undo/Redo 

Z =Edit | Redo  Z = Edit | Undo 

Tab = View | Workmode Tab = View | Smooth
Preview 

    

Tab = Numeric Entry if in Drag 
Mode. 
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Key Shift-Key Ctrl-Key Ctrl-Shift-Key  Alt-Ctrl-Key 

Space = Select | Deselect      

+ = Select | More      

+ = increase of size/sphere of
influence for several
commands. 

     

- = Select | Less      

- = decrease of size/sphere of
influence for several
commands. 

     

F3 = Select | Previous Edge 
Loop 

     

F4 = Select | Next Edge Loop      

F5 = Select | By | Faces with | 5
or more 

     

Bksp = Vertex |Collapse 

Bksp = Edge | Dissolve 

Bksp = Face | Dissolve 

Bksp = Body | Delete 

     

Del  = Vertex | Dissolve 

Del = Edge | Dissolve 

Del = Face | Dissolve 

Del = Body | Delete 

     

2 = Edge | Cut | 2      

3 = Edge | Cut | 3      

4 = Edge | Cut | 4      

5 = Edge | Cut | 5      

6 = Edge | Cut | 6      

7 = Edge | Cut | 7      

8 = Edge | Cut | 8      

9 = Edge | Cut | 9      

0 = Edge | Cut | 10      
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SECTION 6: WINDOWS 

6.1 OUTLINER 
The Outliner gives a list of all objects, images, lights and materials used in the workspace. You can 
quickly edit, with a right click, all of the items in this list.  
 
 
 

Quick Tip: Drag and Drop 
Currently, you can drag a material into the Geometry window and you can drag an image into the 
AutoUV window. There will be more in a future release. 
Tip by Bjorn Gustavsson 
 

6.2 Geometry graph 
The geometry graph only list the objects, including lights in the workspace. Here you can lock, 
hide, duplicate and rename objects. The graph becomes more important as the number of objects 
in your scene increases.  
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Section 6.3 UV Mapping 

The UV Mapping Segmenting Mode window.  Note the new menu available in this mode. Here 
you will divide up your model into slices called charts which will be laid out on a texture map. You 
can hand create the charts or have wings do it for you. 

UV MAPPING | SEGMENTING MODE 
There is a new step in the autoUV, called 
'segmenting'. You use the segmenting step 
to create charts and cuts. A chart is an area 
(a set of connected faces) of your model that 
will mapped to a 2d surface as a separated 
area. You can let Wings do the work for you 
by clicking continue or if you want more 
control you can do it yourself in this window. 
This sections explains how. 
 
 
When you enter the segmenting step, you'll 
have the model’s materials as your charts, 
you can use them as your charts by pressing 
'continue'. You can also do it by hand to have 
more control over how the charts are 

created. Select faces and choose one of the 
AuvChart[1-9] charts. If two, or more, 
groups of selected faces use the same 
AuvChartX they will treated as two, or more, 
charts if they share no edges. In this way you 
can create more than 9 charts. 

Continue 
Despite being on top of the list Continue will 
be the last thing you will do. When your 
satisfied with your charts (and cuts if your 
are going to use the unfold algorithm). Press 
'continue' and choose the 3d to 2d mapper; 
method. Projection or Unfolding. 



Section 5.2 6 AutoUV Mapping  WINGS3D USER MANUAL 

104 DRAFT 1.6  

Continue | Projection 
Projection computes the weighted normal for 
the chart (larger faces contribute more to 
the normal than smaller faces) and projects 
the 3d to chart on a 2d plane (This was the 
method used in the old autouv). Projection 
needs almost flat charts (2d planes) to be 
able to create a good 2d mapping. It will also 
use your materials as a guide to breaking up 
your model into smaller charts. 
 

Continue | Unfolding 
Unfolding computes a 2d drawing by 
unfolding the model mathematically, this 
method should be used when your charts 
isn't flat (close a 2d plane). If you have bad 
charts and cuts the unfolding algorithm may 
produce strange results, but provided good 
charts and cuts in the right places, the result 
should be acceptable. 
 
When the mapping 3d to 2d is done you end 
up in the autouv window, which works as 
before. 
 

SEGMENT BY | PROJECTION 

There are basically three ways you can 
segment (or cut up) your model for UV 
mapping. Two of them are so fast and easy 
as to truly merit the name AutoUV. The third 
method is not much harder, once you get the 
feel for it, and much more suited for complex 
models. We will discuss the first two 
methods first, and save the third for last. 
 
If your model is fairly simple in nature (such 
as my smoothed cube) it is a good candidate 

for using one of the truly automated methods 
of segmentation. If you choose Segment By 
you will be given the choices of Projection or 
Feature Detection. Choosing Projection will 
segment the model so that faces are chosen 
based on which of the six primary axes they 
most closely approximate. Below you can see 
that my smoothed cube has been assigned 
six materials based on their orientation. This 
should minimize stretching in the UV map. 
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SEGMENT BY | FEATURE DETECTION 
This option will automatically segment your 
model into the minimum number of charts 
necessary; often just two. Below you can see 
that my smoothed cube has been assigned 
two materials, breaking the model into two 
nearly equal sections. While this is very fast 
and easy, it could lead to layout and/or 

stretching problems later, when trying to 
paint the texture on the resulting map. 
 
Note that I picked up where I left off, that the 
smoothed cube starts out here projected. 
You can switch back and forth between the 
two as long as you do not choose Continue. 

 

AuvChart1~9 
Charts should be created with care, they 
should be used to minimize the stretching 
and still contain something that you are able 
to paint. Fewer charts is better from a user 
perspective because they are easier to paint 
on, but more charts will lay flatter so they will 
have less texture stretching. You will have to 
deside how best to divide the surface so that 
it is as flat as possible. 
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Creating Cuts 
 

The Segmenting Right 
Click Menu 
The third option is to segment your model by 
hand. The task is to break up your model into 
as many charts as you need in order to make 
your model lay flat. A flat model will not have 
texture stretching, but if you make too many 
charts you will not be able to easily paint your 
textures. The art of proper chart number to 
ease of painting is a skill learned with 
practice. Once you have finished making your 
charts and appropriate cuts you click 
Continue | Unfolding 

Mark edges for Cuts 
A 'Cut' is used to simplify a chart for the UV 
Mapper to correctly spread out your charts 
on the texture. If you want to unfold a cube in 
one chart, you can do that by cutting the 
correct edges, or if you want a spherical or 
cylindrical mapping you must have cuts. A 
spherical mapping is done by making a cut 
between the poles of the sphere. And a 
cylindrical mapping is done by making three 
charts, two discs, one with a cut. See the 
image on the right.  
 

Quick Tip: Using Cuts 
In the cube example, there is only one chart. 
I selected the edges that are green and used 

the command "Mark Edge for Cut". I then 
choose "Continue | Unfolding". 
 
In the cylinder example, there are three 
charts. To have the middle part of the 
cylinder unfold properly, I have marked a 
single cut along one vertical edge. In this 
case I simply used "Segment by | Feature 
Detection" which created the charts and the 
cut automatically. I can keep the layout it 
gave me or do some minor edits. Once done 
I click the Continue | Unfolding.  
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SEGMENT BY | FEATURE DETECTION 
 
Once you have decided on how to segment 
your model (via Projection, Feature 
Detection, or by hand) then you can use the 
Continue option. This will bring up a new 
window titled AutoUV, which will contain the 

layout for your texture map. In the example 
above you can see that I had done my 
segmenting by Projection (left image) and 
then by selecting Continue an AutoUV map 
comes up (right image) with the model nicely 
laid out. 

 
 
Quick Tip: Is having more charts 
better 
I think the general rule is that fewer charts 
gives more stretching per chart but are 
easier to paint. Both these ops gives the 
user an initial suggestion, which they can 
alter, but feature detection shouldn't be used 
together with projection parameterization. 
Projection segmentation often gives more 
charts than feature detection. 

 

Quick tip: Updating the UV Maps 
after edits to the mesh 
Here is a tip that might not be obvious. 
 
Let's assume that you have done some 
changes in the segmenting phase. You might 
have recolored faces or cut edges. You then 
do "Continue | Unfolding" and find that the 

result is not quite what you expected. For 
instance, you might want to have chart cut 
or split in two. 
 
Currently, there is no way to go back to the 
segmenting phase directly. But the following 
trick will work: 
 
1) Quit and save all changes. 
2) Use the "UV Mapping" command again. 
3) You will be asked whether you want to edit 
the current UV mapping or discard the 
current UV mapping and start over. 
4) Choose the second alternative - to 
DISCARD the UV mapping. The texture and 
UV coordinates will be discarded, but before 
they are discarded, AutoUV will use them 
pre-color faces and insert cuts according to 
the UV coordinates. 
5) Do the needed changes. 
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AUTO UV WINDOW 

Once you have your charts in the Auto UV 
window you can further tweak the position of 
your charts to make it easier to paint them 
without getting stretching. You have a small 
selection of tools with which to edit the 
charts. All edits affect the entire chart. 
Currently there is no way to reposition 
vertices directly in this window. 

Move 
Move allows free movement in the whindow. 

Scale 
Scale only allows uniform scaling. 

Rotate 
This gives you the following options 
 Z  Free 
 Z  90 deg 
 Z -90 deg 
 Z 180 deg 
  X 180 deg 
 Y 180 deg 

Rescale all 
Place objects in the lower left hand corner of 
the texture (the square). Rescale then tries 

to squeeze everything else back in to fit on 
the texture. 

ReMap UV 
This has three options.  
 Project normal –Projects UV from 

chart normal. 
 Unfold ? 
 Stretch Optimization – ? 
Project normal and unfold . 

Draw Options 
These are the settings for texture size, 
showing textures and colors in the 
background. And others. 

Apply Texture 
Applies the texture to the object. (you will 
need to right click on the AutoUV window to 
close it. 

Quit 
Quits out of the AutoUV window and asks if 
you want to discard or keep your texture.  
 
. 
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SECTION 7: PLUG-INS 

It is beyond the scope of this manual to delve 
deeply into the operation of all the plug-ins 
available for Wings3D. Please contact the 
authors of the given plug-in for any additional 
documentation or guidance that may be 
available. This section is largely of historical 
interest since many of these plug-in have 
since been incorporated into the Wings core 
program. However, I include them here 
because they are still valuable as learning 
examples for anyone seeking to develop their 
own plug-ins and because the authors of 
these plug-ins deserve some public 
recognition here for the contributions they 

have made. I make no effort to distinguish 
between historic and current plug-ins 
because they change frequently enough to 
make that distinction irrelevant in this 
format. A plug-in today could easily be part of 
the Wings core tomorrow. In this section I 
will briefly describe the known plug-ins at this 
time, give a brief description of what they do, 
and provide a link to where they can be found 
(or could be found at the time of this writing). 
I apologize for any omissions on my part and 
will gladly include any other plug-ins that I am 
made aware of. 

 

Draw Loop Plug-in by clacos 
Link: http://membres.lycos.fr/dong3d/plugsdone 
Installation: Place in the wings3d/plugins/commands directory. 
Description: Adds the Draw Loop command to the Tools menu. When invoked ... 
Usage: When invoked...  
 

Extended Renderman Output Plug-in Additions made by Danni Coy 
(rgcoy@midcoast.com.au) 
Link: http://www.midcoast.com.au/~rgcoy/hobbies/wings.html 

Installation: Run the windows installer (no special requirements). 

Description: Adds 3 new menu entries to the export and export selected menus: 

 RM Subdivision Mesh (.rib) 

Exports each Object to Renderman compliant Subdivision Mesh with a default lighting and material 
setup. Materials are based on the first material found. Hard edges are converted to creases. 
Faces with the Hole material applied are converted to holes. If the model has UV coordinates 
these are written and Texture maps (if any) are exported as TIFF. Note that the renderer must 
support "facevarying" option for UV's to work. 

 RM Points Polygons (.rib) 

Exports each object to Renderman compliant Points Polygons Mesh with a default lighting and 
material setup. Materials are based on the first material found. If the model has UV coordinates 
these are written and Texture maps (if any) are exported as TIFF. Note that the renderer must 
support "facevarying" option for UV's to work. 

 RM Unoptomised Polygons (.rib) 

Exports each object to Renderman compliant Points Polygons Mesh with a default lighting and 
material setup. Materials are based on the first material found. Expands vertex list so that the 
number of Vertex Coordinates = the number of UV Coordinates. If the model has UV coordinates 
these are written and texture maps (if any) are exported as TIFFs. Note, designed to work for 
Renders that do not support "facevarying". 

Usage: 
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Geodesic Dome Primitive Plug-in by Nathan Hauck 
Link: http://www.liquid2k.com/deta_nate/wpc_geosphere.erl 

Installation: Save file to plugin\primitives in your wings directory 

Description: Creates an 80 sided geodesic sphere good for low polygon spheres for games, 
creating domes, and other things. Try Inset and then Intrude on this, then go inside. 

Usage: It will appear in the object creation menu as geosphere.  

Ggalien plug-in by Sean Hinde (earlyriser), original C coding by Mark Whittemore 

Link: http://www.earlyriser.org/ 

Description: When completed this will allow complex procedural primitives to be generated. 

Installation: Does not work with the current version of Wings. However the original C program 
can be run as a stand alone and is available from[marks url] 

Usage: The project is on hold as of this writing, but the source code is available for anyone else 
who wants to pick up the torch. 

Plane Plug-in by Anthony D'Agostino (scorpius) 

Link: ourworld.compuserve.com/homepages/scorpius/uvtorus.zip 

Description: This plug-in enables Wings to generate four types of planes. In addition to a standard 
plane, it can create three variations: wavy, lumpy, and a sombrero surface. The user can specify 
the resolution and size (the variations also allow one to specify the number of lumps, waves, wave-
height, etc).  

Installation: Unzip the archive in the Wings3d directory. 

Usage: Find the new primitives in the object creation menu. 

POV-Ray Plug-in by This Guy (handle) 
Link: http://www.midcoast.com.au/~rgcoy/hobbies/wings.html  
Installation: tell them how. 
Description: The current version supports Mesh2 meshes, to either Povray 3.5 or Megapov 0.7. 
Fixed a few problems including a conflict with either AutoUV or Draw Loop. Fixed support for 
textures. A small bug still remains; temporary images are not deleted while rendering. 
Usage: How to use it. 

Slide Plug-in by clacos 
Link: http://membres.lycos.fr/dong3d/plugsdone 
Installation: Place in the wings3d/plugins/commands directory. 
Description: Adds the Slide command to the Tools menu. 
Usage: Pick a vertex to slide and then choose an edge to slide it along. 

Text, AI, Triangulate, Quadrangulate, Tweak Plug-in by Howard Trickey 
(howardt) 
Link: http://cm.bell-labs.com/cm/cs/who/howard/wplug-ins.html 
Description: This plug-in allows you to add 3D text via TrueType fonts, import Adobe® Illustrator 
(.ai) files, Triangulate, Quadrangulate, and Tweak your models. 
Installation: Extract it in your main wings directory. 
Usage: This plug-in adds five major functions to Wings. This functionality is accessed as follows:  
FILE | IMPORT | ADOBE ILLUSTRATOR FILE Creates an object from the closed outlines in an 
Adobe® Illustrator file. The plug-in asks for the file name and the number of times to bisect edges 
(higher numbers give shapes closer to the intended shapes, and also may avoid problems due to 
self-crossing of the polygonal approximation). The plug-in makes its own decision (based on 
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containment) about which closed contours form holes within other faces. The faces are extruded 
and then quadrangulated. 
 
OBJECT MENU | TEXT Creates an object formed from characters in a TrueType font. The plug-in 
asks for the font file name (note: this is usually different from the "font name"), a string of 
characters to create the object from, and a number of times to bisect the edges (higher numbers 
will give shapes truer to their intended form). The character outlines are extruded and then both 
sides are quadrangulated.  Now, under Windows, as an alternative to giving a font file name, you 
can instead give a "font name", as it appears in a font browse dialog. If you give a file name, you 
must give the full path; if you give a font name, it must appear without a directory name. 
FACE MENU | TESSELATE | TRIANGULATE Takes each selected face in turn and triangulates 
those faces that contain four or more edges. The triangulation is supposed to be "good" in some 
technical sense. 
FACE MENU | TESSELATE | QUADRANGULATE Takes each selected face in turn and 
quadrangulates those faces that contain five or more edges. Quadrangulation means to divide into 
convex quadrilaterals; sometimes this can't always be done, so some triangles may remain. The 
quadrangulation is supposed to be "good" in some technical sense. 
VERTEX MENU | TWEAK Puts Wings in a special mode for quickly editing vertex positions. After 
invoking the tweak command, the current selection mode and selection is saved. Then you may 
click on and drag one vertex at a time. The vertex moves in the plane parallel to the view plane 
(the same as "move free"). You may do camera operations in between dragging vertices, but 
nothing else. A right-mouse-button click exits tweak mode and restores the saved selection and 
selection mode. 

Torus Plug-in by Anthony D'Agostino (scorpius) 
Link: http://ourworld.compuserve.com/homepages/scorpius/uvtorus.zip 

Description: This plug-in enables Wings to generate three types of tori: a standard torus and two 
variations (like those included with LightFlow). It allows the user to specify the major and minor 
radius as well as the U and V resolution. For the two variations, a loop and loop radius can also be 
specified, along with other parameters for finer control. 

Installation: Unzip the archive in the Wings3d directory. 

Usage: Find the new primitives in the object creation menu. 

Hint: To keep faces square, make sure Ures/Vres equals Major/Minor Radius. 

Turn-edge plug-in by Chris Osgood (WingsOne) 
Link: www.functionalfuture.com/wingsone 

Description:  

Installation: Unzip in your Wings folder. 

Usage: Use 't' hot key for normal turn, 'T' for optimized turn. 

Virtual Mirror plug-in by Chris Osgood (WingsOne) 

Link: www.functionalfuture.com/wingsone 

Description: When completed this will enable virtual mirror modeling in Wings. 

Installation: None. 

Usage: The project is on hold as of this writing, but the source code is available for anyone else 
who wants to pick up the torch. 
Just as an historical note, many former plug-ins by Sean Hinde, Anthony D'Agostino and Chris 
Osgood have been incorporated into the standard Wings3D distributions and therefore no longer 
need to be installed as plug-ins. Notable among these are VRML export, torus knot, advanced 
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menus, virtual mirror, and vector operations. They also have lots of other goodies related to 
Wings at their web sites including the Windows installer Chris uses for his stuff; and Mac OSX 
binaries, and an Erlang Tutorial for C, C++ and Java Programmers at Sean’s site. 

 

YafRay 

 
YafRay is an external ray-trace renderer you can download from;  
 
http://www.yafray.org 
 
Follow the directions to install it to your hard drive. Once installed you will need to add it’s location 
to your path. The path is a list of locations that will be searched for software. 

WINDOWS 

In windows 98 you edit your autoexec.bat. in it you will see a line that reads something like 
Path=C:\; C:\windows; C:\windows\system; etc… At the end of this list of locations add a 
semicolon, a space and c:\yafray 
 
When you restart your machine it will be added to the paths. 
 
Windows 2000/Windows 2K uses the same convention but in a different place. you right click on 
My Computer Click the advanced tab. Then click on the variables button. Here you will find two 
windows with various settings. Look in the lower one labeled System Variables. You should see a 
variable named path. Double-click it and it will open a property panel to change it. Add ; C:\yafray 
to the end of the list of paths (only use one ; between each path) If no Path variable is there add it 
by clicking the New button under system Variables.  
 
Variable Name is Path  
Value is C:\yafray 
. 
A YafRay plug-in comes with Wings3D, when Wings3D starts the plug-in looks to see if the YafRay 
software is installed. If Wings3D can find YafRay in the path then it will add it as a render choice 
as shown in the image above. 
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Producing an image 
In order for wings to render out your scenes you will need to add at least one light. Although more 
may be needed to fill in the shadows properly. The lights have additional YafRay settings that can 
be used such as diffuse, caustics, depth and power to name a few.  
Renders are shown inside Wings3D when they are done. 

MAC 

The Mac OS X version of YafRay runs from the command line so you’ll have to get familiar with a 
few commands to get around in Linux territory. Currently Wings3D cannot send files to render 
with YafRay. 
 
YafRay installs itself in /usr/bin/ on your hard drive, which is not visible except in the terminal 
window. In the terminal window if you type yafray you will see that it can be accessed from any 
folder, (terminal normally starts in the user folder.) but your files to render you will have to enter 
the entire path. Start by adding YafRay to Wings3D so that you can export .xml files. 
 
In Wings3D 
 
go to edit > Plug-in Preferences > YafRay 
 
where it says Rendering Command line enter /usr/bin/yafray 
 
YafRay will appear in the render and export menu although it won't render.  
 
Now you will have the option of exporting a YafRay .xml file. When naming your export files don’t 
use spaces. Use an underscore if you want to space out the name. You will also have to save the 
file to a folder that also has no spaces in the name. On the Hard Drive I made a folder called 
yafray to save all the .xml files to.  
 
To render on my machine I go to the terminal and type in yafray followed by the entire path to the 
file (a beginning backslash followed by the folder names separated by backslashes. The entire path 
for my example would be; 
 
yafray /yafray/myfile.xml  
 
with myfile being the actual file name. 
 
When you run a render through the terminal, spaces are read as the end of the command. So if 
you saved your file to your document folder in the user folders this; 
 
yafray /users/john doe/documents/myfile.xml 
 
Would become; 
 
yafray /users/john 
 
which would result in an error. The simplest solution is just to make a folder on your hard drive 
with no spaces in it. It also means less typing. 
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SECTION 8: RESOURCES 

8.1 Wings3D Links 
Wings3D Home Page – Here you will find the latest source code and Windows binaries, several 
tutorials and some useful links. 
Link: www.wings3d.com 
 
SourceForge Wings Project Page – Here you can find both the current and historical source 
code and release notes, file a bug reports, or log feature requests.  
Link: http://sourceforge.net/projects/wings 
 
Erlang – the Wings programming language. The best reference is the PDF document Concurrent 
Programming in Erlang which is the first six chapters of a book by the same name. Most of the 
people now writing plug-ins for Wings got started by reading this document. You will also find a 
Glossary, an Index and a Getting Started guide at the same site. Link: http://www.erlang.org/ 
 
Wings Warm & Fuzzy 3D – Wings discussions. This is the unofficial Official Wings Board. This is 
where most of the on-line Wings discussion takes place, especially oriented to helping new users 
and for hashing out development issues.  
Link: http://pub33.ezboard.com/bnendowingsmirai 
 
CGChat Wings Board – A Wings discussion board more centered around the art of modeling with 
Wings. They tend to run Seminars on a given modeling topic. 
Link: http://www.cgchat.com/board/forumdisplay.php?s=&forumid=69 
 
Bernie's Downloads – Many free models in .wings format plus other 3D resources. 
Link: http://www.bernieloehn.de/downloads.html 
 
3dbaseart – a Wings tutorial on building a drag car. 
Link: http://www.3dbasedart.com/ 
 
Wings3D Tutorial: Soccer Ball – a tutorial by Anthony D'Agostino on making a soccer ball with 
wings. Anthony is a master at modeling geometric shapes, and this tutorial is Wings3D specific.  
Link: http://ourworld.compuserve.com/homepages/scorpius/tut-wings-soccer.htm 
 
And there are two links that may help you understand the winged edge data structure of Wings 
that I would like to point you to. The first one is The Winged Edge Data Structure by Dr. Ching-
Kuang Shene. This is the reference used by Bjorn Gustravson to develop Wings. 
Link: http://www.cs.mtu.edu/~shene/COURSES/cs3621/NOTES/model/winged-e.html 
 
And you can find winged edge topology illustrated from a geographic point of view here: 
Link: http://www.bequia.swinternet.co.uk/edgeex.html 
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8.2 Polygon Modeling Links 
IZware – Nendo® download and discussions, Mirai discussions. Nendo® is a fantastic modeler 
and was the inspiration for Wings. The demo is fully functional except for the ability to export to 
other formats and the full version is only $99. Sadly, hard to get. 
Link: www.izware.com 
 
Amim8or – Anim8or download, tutorials and discussions.  
Link: http://www.anim8or.com/main/index.html 
 
The Human Head – a reference for 3D artists by Ron Lemen. This is not really a subdivision 
modeling tutorial but a drawing tutorial. But it will help teach you the proper proportions and 
shapes needed for modeling a head.  
Link: http://www.anticz.com/heads.htm 
 
3D Animation Workshop by Robert Polevoi – An excellent series of lessons on all things 3D. The 
topics range from general 3D concepts to application specific techniques. Lessons 51, 52, and 
53 deal with subdivision modeling with Nendo®, but take the time to read some of the earlier 
lessons (1 – 23) to get a grasp on 3D concepts in general. The VRML lessons are very good 
(Lessons  27 – 32 and 40 – 45). Lessons 101 – 104 take you through human character 
modeling, albeit via 3D Max, but they are useful. Unfortunately Mr. Polevoi is no longer producing 
this series, but it is still valuable reading.  
Link: http://www.webreference.com/3d/indexa.html 
 
Subdivision Modeling Resource Page by Tamas Varga. It is Mirai centric but there are good 
discussions on topics fairly universal to subdivision modeling such as the concept of Edge Loops.  
Link: http://maxrovat.sns.hu/subdiv/ 
 
Subdivision Surface Modeling 101 by Erik Asorson, is a 3D Max web page but  many of the 
concepts transfer nicely to other applications as well.  
Link: http://www.geocities.com/fyer_starter/tut_1subd.html 
 
Mastering 3D Animation by Peter Ratner, professor of Art at James Madison University. An 
excellent trilogy of tutorials that cover modeling the human head, the human body, and adding 
muscles and details.  
Link: http://www.3dlinks.com/tutorials/GENERAL/Face_Modeling_1.cfm 
 
Spiraloid Digital Sculpting Forum – moderated discussions. What reference guide would be 
complete without a link to the Spiraloid Digital Sculpting Forum. This is a closely moderated 
community so be sure to read the rules before posting to avoid being ejected. Very informative 
discussions from a great collection of master modelers. Just go, read and learn. And if you post, 
be polite, ask – don't demand, and don't forget to put in that link or image in your post (if you read 
the rules you know what I mean).  
Link: http://cube.phlatt.net/forums/spiraloid/ 
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8.3 UVMapping and Texturing Links 
UVMapper – You can download the free "Classic" version or buy the new low cost "Pro" version if 
this UV mapping mainstay. Has a live link to your paint program, so that you can see changes to 
your texture map almost in real time (Pro version).  
Link: www.uvmapper.com 
 
UltimateUnwrap3D – Another mainstay in the UV mapping software area. 
Link: http:Error! Hyperlink reference not valid. 
 
Project Dogwaffle – free natural paint program with an SDK for plug-in developers. 
Link: http://www.geocities.com/SiliconValley/Ridge/7251/cyberop.htm 
 
The Gimp – a very powerful OpenSource paint program. 
Link: http://www.gimp.org/ 
 
Infinity Textures – seamless texture generation software. Very reasonably priced ($69). 
Link: http://www.i-tex.de/ 
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8.4 Rendering Links 
Air – a RIB rendering front end. The free version is limited to 4 lights. 
Link: http://www.sitexgraphics.com/index.htm 
 
Aqsis – an OpenSource RIB renderer. 
Link: http://www.aqsis.com/ 
 
Art of Illusion – an OpenSource 3D modeling, animation and rendering package written entirely in 
Java (download once, run anywhere). Now supports scripting. 
Link:  http://www.artofillusion.org/index  
 
Now3D – a freeware rendering package. 
Link: http://web.tiscali.it/GiulianoCornacchiola/Eng/ 
 
Persistence of Vision Raytracer (POV-Ray) – a command line 3D modeler and rendering 
package. 
Link: http://www.povray.org/ 
 
Poser – character rendering and animation. 
Link: http://www.curiouslabs.com/ 
 
Vue d'Esprit – a landscape and general purpose renderer. 
Link: http://www.e-onsoftware.com/ 
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8.5 Graphic Utilities 
Camtasia – desktop video capture software. 
Link: http://www.techsmith.com/ 
 
HyperCam – desktop video capture shareware. 
Link: http://www.hyperionics.com/hc/ 
 
CamStudio – an OpenSource desktop video capture package. 
Link: http://www.atomixbuttons.com/vsc/index1.html 
 
Virtual Dub – an OpenSource AVI editing software distributed under the GNU GPL. 
Link: http://www.virtualdub.org/ 
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8.6 Specialty Applications 
3D Dictionary – an on-line project that you can contribute to. Very handy dictionary. 
Link: http://oss.ckk.chalmers.se/dictionary/ 
 
Forester – landscape generator, with Arboretum, a tree generator. 
Link: http://www.dartnall.f9.co.uk/forester/main.htm 
 
Terragen – a landscape generator/renderer. 
Link: http://www.planetside.co.uk/terragen/ 
 
World Machine – a landscape generator (Beta). 
Link: http://students.washington.edu/sschmitt/world/ 
 
Radon Labs – a 3D game engine. 
Link: http://www.radonlabs.de/ 
 
Genesis3D – a 3D game engine. 
Link: http://www.genesis3d.com/ 
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8.7 Books 
3D Modeling and Surfacing by Bill Fleming, © 1999 by Academic Press; 340 pp. This is the best 
general introduction to 3D Modeling I have found. Over half the book is dedicated to principles of 
polygon modeling in one form or another, plus he explains NURBS based modeling, and the 
principles that deal with texturing. This is not a tutorial, it is a general discussion of principals and 
practices. Well worth while. 
 
Principles of Three-Dimensional Computer Animation by Michael O'Rourke, © 1998 by Michael 
O'Rourke; 285 pp. I found the modeling portion of this book to be too elementary to be of much 
use, but am finding the sections on Rendering and Animation very informative since I have little 
background in those areas. He explains the theories behind lighting, texturing, atmospheric 
effects, keyframing, and inverse kinematics among other things. It reads much more like a text 
book than I would like, but it is very informative. 
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GLOSSARY 

Ambient color – The overall color of an object. When rendering scene ambiance is multiplied by 
face ambiance.5  
Attenuation – The intensity of a light through the scene as it diminishes with distance from the 
source. 
Backface – The interior side of a face on a solid object. 
Bezier – A mathematically defined curve formed by the placement of control points. 
Binaries – Machine readable files created by compiling source code. 
Body – A 3D object composed of vertices, edges and faces. 
Bounding box – Generally, the minimum volume that can contain a selection. However, a single 
vertex bounding box is 0 and a single edge bounding box is two dimensional. 
Box modeling – A common term for the type of polygon modeling used in Wings3D. 
Central edge loop – A set of edges that completely encircles a model on one of the primary axes, 
usually the Z axis, for example as the center line of a head. 
Chart packing -- This is the last step that happens before the AutoUV window appears, i.e. each 
2d chart is placed somewhere on texture. 
Control cage – The model in shaded wireframe mode prior to any smoothing operation. 
Crease angle – The angle between two faces that share an edge 
Diffuse color – The overall color of a surface absent any highlights, like a matte surface.6  
Display mode – The way a model appears on the screen, solid shaded, smooth shaded, or 
wireframe. 
Dolly – Moving the camera in and out towards or away from the model; i.e. zooming. 
Edge – The boundary between two faces having exactly two vertices; the line joining two vertices 
together. 
Edge loop – A set of edges that connect at vertices with 4 way intersections. 
Edge rings – The lateral edges that run between two adjacent edge loops. 
Element – A graphic element in the scene that can be selected; a vertex, edge, face, body or a 
light are all elements of a scene. 
Emission – A color setting that affect the overall self illumination of the object. 
Face – An element of an object consisting of a set of interconnected edges. 
Facet Subdivision – Breaking down a component of two dimensions (i.e. a face) into more and 
more faceted surfaces (faces) without doing any smoothing. 
GNU GPL – GNU General Public License, one of the most popular OpenSource licensing 
agreements. GNU stands for GNU is Not Unix. 
Ground plane – Usually an imaginary plane used as the horizontal reference plane. 
GUI – Graphic User Interface. 
Linear – A light setting, which causes the light to fall off in a linear manner. 
Material – The underlying surface properties of an object or faces on an object. A material is 
different than a color or texture. Color is but one component of a material and can be applied to 
vertices as well, and textures can be applied over a material.  
Mesh – A 3D object composed of interconnected faces, usually composed of triangles, quads and 
n-gons. 
Metaform subdivision – A subdivision method which shows the smoothed model with the 
unsmoothed cage floating about it. 
N-gons – A face with more than 4 sides. 
Normal – A vector that extends outward perpendicular to a graphic element.  

                                           
5From the on-line 3D Computer Graphics Dictionary; Entry contributed by Robert Karlsson; © 200 by Chalmers Medialab; 

http://oss.ckk.chalmers.se/dictionary/ 
6O,Rourke, p. 99. 
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NURBS curve – Non-Uniform Rational B-Splines; a mathematically defined curve of infinite 
resolution. 
Object – A self contained solid body composed of vertices, edges and faces also know as a body. 
Opacity – The level of transparency for a face as set in the Material Editor. 
Organic model – A model of a non-manufactured item, such as living (organic) things. 
Orthogonal – A view that displays a parallel projection along one of the major axis.7 
Orthographic view – The view as it appears when in Orthographic View mode causing the scene 
to not show depth perspective. 
Parameterization -- That is what continue unfold/projection does. It makes a 3d to 2d mapping 
and associates at least one 2d coordinate UV (also named 'ST' in some docs) to each vertex. 
Perspective – A graphic technique that creates the illusion of depth on a two dimensional surface. 
Perspective view – The view as it appears when the Orthographic View option is turned off. Lines 
not parallel to the viewing plane appear to converge towards an imaginary vanishing point, thus 
creating the illusion of depth. 
Pole – Anything other than a 4 way intersection of edges; 2, 3, 5, or more edges intersecting. 
These will stop the flow of an edge loop. 
Polygon modeling – one of the two main modeling techniques, wherein an object is subdivided into 
finer and finer polygons so as to approximate the shape of the intended model. Wings3D is a 
polygon modeler. 
Quadrangulate – The automatic subdivision of faces with more than 4 edges into quads wherever 
possible and triangles when quads are not possible. 
Quadratic – A light setting that causes the light to Fall off in a quadratic manner. 
Quads – Short for Quadlateral. Four sided faces. 
Region – A set of adjoining faces. 
Segmentation -- Where you divide your model into one or more charts. Charts can be cut along 
edges, example if you want a spherical mapping of sphere make a cut from north pole to the 
south pole and continue with unfold. If you cut the sphere with an edge loop you will get 2 charts. 
Shininess – A material parameter that causes highlights on the surface.  
Smooth-shaded – A mode of viewing the model that shows the faces without the edges as if one 
degree of smoothing has been done.  
Smooth subdivision – A method of subdivision modeling that causes the model to smooth out into 
a more organic form when subdivided, as opposed to Facet subdivision.  
Specular color – The color of the reflected light off the surface.  
Specularity – A materials setting that controls the size of the brightest area on a surface, created 
by reflection from the surrounding lights; i.e. highlights. 
Spot angle – A light setting that controls the shape of the light cone generated by a spot light. 
Spot Falloff – A light setting that controls how quickly the light fades from full intensity at the 
center to completely dark at the edges; i.e. How fuzzy the edge of illumination will be.  
Subdivision – Creating two or more faces from a single face.  
Subdivision modeling – A method of modeling solids by dividing its faces into more faces and 
manipulating them to approximate the overall shape of the subject matter. – A method of using a 
low poly cage object to define a smooth object once it is subdivided. 
Subdivision surfaces – the faces that result from subdivision modeling. 
Tessellate – The division of one triangle into multiple triangles to achieve a smoother overall form. 
Track – Moving the camera up and down or back and forth in front of the model.  
Transparency – The amount of opacity of a surface. 
Tris – Short for Triangles 
Triangles – Face made of 3 edges. 
Triangulate – The automated subdivision of faces with four or more edges into triangles. 
Tumble – Moving the camera around the model in 3D space.  
Vector – A line of directionality. 

                                           
7From the on-line 3D Computer Graphics Dictionary; Entry contributed by John Woolfrey 
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Vertex – A point as defined in its X, Y, and Z position in space.  
Widgets – tools.  
Winged-edge topology – A method that mathematically defines all elements in a model by their 
relationships to other elements of the model. A requirement of winged-edge topology is that each 
edge is adjacent to exactly two faces. Another condition that Wings3D imposes (not necessarily 
other programs that use winged-edge topology) is that a given face cannot contain the same edge 
more than once.  
Wireframe – A mode of viewing an object so that the edges are visible but the faces are not.   
Wire-shaded – A mode of viewing an object so that the faces are visible as well as the edges that 
define them. 
Workspace – The working area of a program, also called a view port. 



Section 8: Plug-ins  WINGS3D USER MANUAL 

124 DRAFT 1.6  
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1.2 Edition 
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Steve Lapham for the original dog house tutorial on which the one in this manual is based. 

puzzeledpaul for assistance with the Advanced Menu options and for the Experiment with 
Deformers and the Put On and Bridge Quick Tips. 

Mestela for the Create the Juice (Invert) Quick Tip. 

Nathan Ryan, John Moss, Mike Owen, Janool, and Puzzled Paul  for kindly editing this manual. 

John Moss for usability testing. 

And all the kind folks that contributed to my UM Project and Modeling 101 threads on the Wings 
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forever in your debt. 

1.2 document was entirely written and edited in StarOffice Rev. 5.x and OpenOffice Rev. 1.0.1. 
Screen captures were sized and edited with PaintShop Pro Rev. 6.x. 

Jon 

1.6.1 Edition additions 
Special Thanks to Jon who collected all of this work together into one edition.  

I’d like to also thank all those talented artists who contributed their work to this edition. 
Contributors include; Erin McClellan, Mike Gleason, David Benton, Scott Riding, Mr. Christopher, 
and Mentat7. 

This edition was edited in MS Word. Eurostile, Times Roman and Courier New were used. Screen 
shots gathered from Mac and PC using Photoshop and fireworks. The PDF was collected and 
formatted in Acrobat 4. Screenshots were taken from Wings3D .98.10d and 98.10e.  

Jason
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